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1 System Requirements 
1.1 Hardware Requirements for HiCAD 
For the installation of HiCAD you can use any hardware that possesses current drivers 
for the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set.  

» Hardware requirements (minimum): 

 Pentium 4 compatible processor with SSE2 support 

 4 GB RAM 

 approx. 3 GB disk free space 

 DVD drive 

 Screen resolution of 1280 x 1024  

 Fully OpenGL capable graphics card with at least 128 MB memory (if the error 
message Set Pixel Format failed is issued during program start, the OpenGL driver 
does not support the entire instruction set). You can use the 
OpenGLCapabilityTester to check whether the OpenGL capabilities of your 
computer are sufficient for HiCAD. This tool is available for download at 
www.hicad.isdgroup.eu > Service & Support > FAQ > “What are the System and 
Hardware Requirements?” 

 To achieve optimal performance for large assemblies, the system should possess 
significantly more main memory than is considered sufficient for HiCAD at first glance. This 
enables the hard disk accessing operations Buffer memory, Undo and Switch drawing to be 
performed up to 4 times faster. 

 

» Supported operating systems: 

 Windows 7 (with current service pack and security patches) 

 Windows XP (with current service pack and security patches) 

http://www.hicad.isdgroup.de/cms/dofiles/f_2402_865111e944a215c345d37ddd03418326_0_openglcapabilitytesterpzip.zip
http://www.hicad.isdgroup.eu/
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» Supported database systems (for HiCAD with HELiOS): 

 Microsoft SQL Server 2000 and 2005  

 Oracle Database Server 8i, 9i and 10g 

There are no further requirements for the installation of the HiCAD Version with License 
Management; the legal licensing check is performed during runtime.  

» Optimal hardware equipment (October 2012):  
 

Computer: Fujitsu Siemens Celsius M470 

Processor (CPU): Intel® Xeon® Processor W3550 (8M Cache, 3.06 GHz, 4,80 
GT/s Intel® QPI)  

RAM: 16 GB, DDR3-RAM, 1333 MHz 

Hard disk: 1 SATA II disk (hard disk: Windows),  
1 SSD SATA disk, 128 GB, 2.5 inch (hard disk: HiCAD) 

Screen resolution Full HD (1920x1080) 

Graphics card: NVIDIA Quadro 5000 (2.5 GB) 

Operating system: Windows 7 (64 Bit)  

» Graphic cards 

The following graphic cards are recommended for HiCAD operation:  
 

Supplier Model Operating system (tested) 

Nvidia NVIDIA Quadro 2000 (1 GB) Windows 7, Windows XP 

 NVIDIA Quadro 4000 (2 GB) Windows 7, Windows XP 

 NVIDIA Quadro 5000 (2.5 GB) Windows 7, Windows XP 

 Please note that insufficient graphics hardware will impair the performance and the 
quality of graphical representation! 
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1.2 System Requirements for HELiOS (Standalone) 
For the installation of HELiOS you may use any hardware possessing current drivers for 
the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set.   

» Hardware requirements: 

 Pentium 4 compatible processor with SSE2 support 
 1 GB RAM 

» Supported operating systems: 

 Windows XP (32 Bit, with current service pack and security patches) 
 Windows 7 (with current service pack and security patches)  

» Supported database systems:  

 Microsoft SQL Server 2000 and 2005  
 Oracle Database Server 8i, 9i and 10g. 

» Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to 
be installed on the computer before HELiOS 2012 can be used; these packages will 
be installed by the HELiOS installer if required. 

» If you want to work with HELiOS, one of the above mentioned database systems 
needs to be available and prepared for the use of HELiOS. Installation instructions (in 
.pdf format) and appropriate implementation of the server system can be found in 
the Readme directory of the HELiOS Installation DVD.  
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1.3 Hardware Requirements License Server 
 

Processor (CPU): x86 Processor for 32-Bit / x86-64 Processor for 64-Bit 

Recommended: 2 GHz Processor 

RAM: Minimum: 1 GB  

Recommended: 2 GB (with SQL Server: > 3 GB ) 

Hard disk: 1.2 GB free disk space 

Operating System 
(Server) 

Windows Server 2003 (32 & 64-Bit) 

Windows Server 2008 (32 & 64-Bit) 

Windows Server 2008 R2 (64-Bit) 

Operating System  
(Client) 

Windows XP (32 & 64-Bit)  

Windows Vista (32 & 64-Bit) 

Windows 7 (32 & 64-Bit) 

IP/MAC Adress A static IP address is required for an error-free 
operation of the license server. 

For virtual servers a static MAC address needs to be 
available. 

 

 A license server program does not need to run on a file server system or any specific 
hardware server. Suitable is any computer that fulfils the requirements.  
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1.4 Hardware Requirements HiCAD Spooler 
 

Processor (CPU): Intel or AMD SSE2 Support (64Bit operating system 
recommended, 4GB RAM) 

RAM: 2 GB or more 

Hard disk: 10 GB or more 

Graphics card OpenGL 2.0-capable graphics card with at least 256 
MB memory 

Screen resolution 1280x1024 

Operating system Windows XP 32Bit for a maximum of 10 clients 
(Recommended: Windows 7 – 64Bit) 

For more than 10 workstations: Server operating 
system with a sufficient number of user licenses 

 

1.5 Hardware Requirements Vault Server 
 

Processor (CPU): Pentium III-compatible processor, Minimum: 1,0 GHz 

RAM: Minimum: 1 GB, Recommended: 4 GB or more 

Graphics Card: VGA (no special requirements) 

Hard disk: For software: 100 MB 

For user data: Depending on the amount of data to be 
expected, plus backup memory of >= 100%  

(distribution over several volumes/drives possible, 
redundant array of independent disks (RAID) for primary 
user data recommended) 
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Operating system 
(virtual servers also 
possible): 

 

Windows XP SP3 Professional 
Windows XP SP2 x64 Professional 

Windows 7 Professional 
Windows 7 x64 Professional 

Windows Server 2003 SP2 
Windows Server 2003 SP2 x64  

Windows Server 2003 R2 SP2 
Windows Server 2003 R2 SP2 x64 

Windows Server 2008 SP2 
Windows Server 2008 SP2 x64  

Windows Server 2008 R2 x64 

 

1.6 Further Installation Requirements 
» Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to 

be installed on the computer before HiCAD/HELiOS 2012 can be used; these 
packages will be installed as part of the HiCAD installation if required.  

» The graphics card must support Open GL 2.0 or higher. If the hardware or driver 
does not support this standard, there will be shown a warning message when 
installing HiCAD and a compatibility mode will be used (with low graphic 
performance). 

» If you use Nvidia graphics drivers, the Common background/Z-buffer needs to be 
switched Off (in contrast to HiCAD 2007 or older versions).  

» If you want to work with HELiOS, one of these database systems needs to be 
available and prepared for HELiOS. Installation instructions (in .pdf format) and 
appropriate implementation of the server system can be found in the Readme 
directory of the HELiOS Installation DVD.  

» Current information on system requirements can also be found on the Internet at 
www.hicad.isdgroup.eu > Service & Support > FAQ. 
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2 Installation 
The DVD contains the installation files for:  

» HiCAD 

» HELiOS Desktop (Standalone) 

» The Online Help  

» The Vault Server 

» The Plot Management  

» HiCAD Viewer 

» The License Server (the Hardlock driver is normally no longer required) 

» The PostScript printer driver (required for the output of several views to a PDF file) 

The DVD has been developed for Windows operating systems. When you insert the 
DVD, an installation wizard will be started automatically. 

 

 The HiCAD and HELiOS version must be installed on the hard disk of the computer; it is 
not possible to start the programs from the DVD. 
 

If the Autostart function has been deactivated in the operating system, it is mandatory 
for the installation of HiCAD to start the setup.bat file from the root directory of the DVD; 
only in this way it is ensured that the version of the operation system (32/64Bit) will be 
recognised correctly, and the matching HiCAD version will be installed.   
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In the installation wizard, click the Standard Edition button, which opens a mask with 
various selection options for software components.   

 

Leave this selection mask open, so that you can, one after the other, select the desired 
components.  
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2.1 Installing HiCAD 

 

Click the HiCAD and HELiOS button to start the installation.  

Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to be 
installed on the computer before HiCAD/HELiOS 2012 can be used; these packages will 
be installed as part of the HiCAD installation if required.   
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First, important information about data compatibility will be displayed. Please read this 
information carefully. 
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Specify an installation directory.  

 

Please read the Notes on Hardware Exchange carefully.  
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Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license. If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware.  

Accept the notes to continue with the installation. 

 

You can now start with the installation or modify the Extended Settings, e.g. for the user 
configuration, the catalogues, or HiCAD with HELiOS.  
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In the Configuration Database, customer-specific settings for various features such as 
dimensioning, annotations, workshop drawing creation or fitting of vertical ladders are 
stored. When making an update, customer-specific settings can be applied. In addition, 
values that have not been modified by the user will automatically obtain the updated 
pre-settings.  

Depending on the selection in this window, the settings stored in the CSV file, too, will 
be applied. The standard CSV files are located in the templates directory of the HiCAD 
installation. CSV files are configuration templates that you can create and edit with 
Microsoft Excel (please see Online Help). 

Parameter configuration: No templates (see Parameter Configuration chapter) is 
activated by default. You can also change this setting subsequently, via the programs 
..exe/ParKonfigComp.exe (for the workstation) and ..exe/ParKonfigUser.exe (for the 
User). 
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The execution of the CatalogueMaker serves the purpose of specifying which standard 
series are to appear in the standard part catalogues (currently standard series are 
available for DIN, ISO, EN, ANSI and JIS); the selection of standards in the 
CatalogueMaker only influences the display of standard parts, but not their availability; 
the availability is still controlled via license selection in the ISD License Manager.    

When Updates are made, the existing configuration will be applied, and the 
CatalogueMaker will not be started automatically. If you want to add standards to the 
catalogues, the program can be called via Start > All Programs > ISD Software und 
Systeme GmbH > Administration.  
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In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login.  

If you want to process your print jobs via the ISD Plot Management, you need to install 
one PrintClient on each workstation. In the Server field, enter the network name of the 
computer on which the Spooler is installed. The Spooler collects the print jobs and 
processes them, taking your settings into account.   

 

 

You use the the License Administration Tools for the installation of server licenses.  
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 Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be 
started. 

 

 

Click Finish to complete your HiCAD installation. If desired, you can use the buttons of 
the installation mask to install further software components.  
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2.2 Installing HELiOS Desktop (Standalone) 
The HELiOS Desktop is normally installed automatically when you install HiCAD. Of 
course, you can also install HELiOS separately. To do this, start Windows. If Windows is 
already open, close all other applications. Insert the HELiOS DVD in your DVD drive. 
The installation wizard will be started automatically. Follow the instructions on the 
screen.  

In the installation wizard, click the Standard Edition button, which opens a mask with 
various selection options for software components. Please leave this selection mask 
open, so that you can, one after the other, install the desired components.  

 

Click the HELiOS button. 

 

 



Installation 

   27 

 

Select Update-Installation, if a HELiOS Desktop has already been installed on your 
computer.  
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Please read the Notes on Hardware Exchange carefully.  

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license. If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware. 

Accept the notes to continue with the installation. 
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You can now start with the installation or modify the Extended Settings, e.g. for HELiOS. 

 

In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login.  
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Enable the License Administration Tools, as they are required for the installation of 
server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be 
started. 

 

After successful installation, you will find the HELiOS shortcut on the Desktop for 
program launch.  
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2.3 Installing the Online Help  
The Online Help is available locally (status of the date of installation DVD creation) and 
on the Internet (regularly updated) at www.help.isdgroup.com. Both versions of the 
Help can be directly launched from HiCAD. Please note that corresponding login data 
are required to access the Internet version of the Help.  

Start Windows to install the Help. If Windows is already open, close all other 
applications. Insert the DVD in the drive, which automatically starts the installation 
wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components. Please leave this selection 
mask open, so that you can, one after the other, install the desired components. 

 

Click the HiCAD and HELiOS Help button. 

 

http://www.help.isdgroup.com/
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Specify the installation directory for HiCAD/HELiOS. 
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After successful installation, the Help can be found in the program folder and can be 
called via HiCAD/HELiOS.  

 



Installation 

 34 UNLIMITED PERFORMANCE 

2.4 Installing the Vault Server  
Start Windows to install the Vault Server. If Windows is already open, close all other 
applications. Insert the DVD in the DVD drive, which automatically starts the installation 
wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components. Please leave this selection 
mask open, so that you can, one after the other, install the desired components. 

 

Click the Vault Server button. 

 



Installation 

   35 

 

Specify the installation directory of the Vault Server. 

 

Give the Vault Server a name, e.g. the name of your company, plus the location of your 
company. This name will be shown, for example, when you connect to the Vault Server 
from the Vault Client.   
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The Vault Server renames all documents that are managed in the database (e.g. SZA, 
DOC, XLS, …) to *.VDF. These VDF files are saved to the Document directory.  

The files stored in the Management directory contain the assignments of the VDF file 
names to the “original file names”.   

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF 
files. 

Enter the name of the log file in the Log file name field. The name of the Vault Server 
would also be possible here. If the log file exceeds a certain length, it will be cut down 
and suffixed by the current date. 
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Click the Install button.  

 

Click Finish to complete the installation of the Vault Server. You can now install further 
components offered in the selection mask if desired. 
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2.5 Installing the HiCAD Spooler  
The Plot Management consists of the following two components: 

» HiCAD PrintClient (part of the HiCAD installation; is installed on each workstation) 

» HiCAD Spooler (is installed on the Server only) 

Start Windows to install the components of the plot management. If Windows is already 
open, close all other applications. Insert the DVD in the DVD drive, which automatically 
starts the installation wizard. In the installation wizard, click the Standard Edition 
button, which opens a mask with various selection options for software components. 
Please leave this selection mask open, so that you can, one after the other, install the 
desired components.  

 

 If you use Windows XP, Service Pack 3 is required for the Spooler. 

 

 

Click the HiCAD Spooler button. 
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First, important information about data compatibility will be displayed. Please read this 
information carefully. 
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Specify the installation directory for the software. 

 

Please read the Notes on Hardware Exchange carefully. Accept the notes to continue 
with the installation.  
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If you want to print your documents via the Plot Management of the ISD, you need to 
install one PrintClient on each workstation. In the Server field, enter the network name 
of the computer on which the Spooler is installed. The Spooler manages the print jobs 
and processes them according to your settings. 

 

You can now click Install to start the installation, or modify the Extended settings, e.g. 
for the user configuration or the catalogues. The Extended Settings here are modified in 
the same way as the Extended Settings for the HiCAD. 
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Then click Install. 

 

 

After successful installation, the HiCAD Spooler will be located in the program folder.  
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2.6 Parameter Configuration 
HiCAD provides suitably customised interfaces and configurations for various fields of 
engineering, e.g. for Mechanical Engineering, Steel Engineering, Metal Engineering or 
Plant Engineering. You can select these options during the installation of HiCAD 
(Extended Settings > User Configuration > Use ISD Standard Templates).  

To change the parameter configuration subsequently, start the programs 

» ..exe/ParKonfigComp.exe for the workstation configuration, and 

» ..exe/ParKonfigUser.exe for the user configuration. 

 

In the dialogue window you have the following setting options:  

» Module 
Here you choose the required filed of engineering. The common HiCAD parameters 
are then configured for this area. 
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» Font 
Specifies the text font default setting, e.g. for dimensioning, title blocks, view 
labelling, annotation etc. 

» HiCAD/HELiOS Default Solution 
Provides you with a preconfigured database solution for a safe and convenient 
management of product data. If you want to use it, activate the checkbox.  

» Attribute configuration according to DSTV  
If you want the HiCAD attribute masks for parts and drawings to obtain the DSTV-
relevant attributes, please activate the appropriate checkbox. The files 
BRW_3DTEIL.HDX and BRW_SZENE.HDX in the HiCAD SYS directory will be preset 
for DSTV BOM configuration.  

» Use ISD standard template; Module: Steel Engineering: 
 

Short description Default  HiCAD configuration file  Line 

General: Zoom factor <F2>-Zoom 5.0 sys\grapar.dat 50 

General: Zoom window size <F2>-
Zoom 

0.9 sys\grapar.dat 52 

Type of weight calculation for 
beams+profiles  (1 = Exact volume * 
Density, 2 = DIN weight, Commercial 
weight) 

2 sys\stb_parameter.dat 9 

Type of weight calculation for 
plates+sheets (1 = Exact volume * 
Density, 2 = Length*Width*Thickness 
* Density) 

2 sys\stb_parameter.dat 9 

Representation of beams + profiles  
(0 = Simplified, 1 = Exact, 2 = Axis 
only) 

0 sys\stb_parameter.dat 19 

First Steel Engineering part item 
number 

100 sys\stb_parameter.dat 31 

Type of detection for first item 
number of main parts and sub-parts 
(1 = Start value, 2 = Factor, 3 = 
Allowance) 

3 sys\stb_parameter.dat 34 
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Short description Default  HiCAD configuration file  Line 

Itemisation of Standard Parts (0 = No, 
1 = Yes) 

1 10000 sys\stb_parameter.dat 38 

Itemisation of non-Steel Engineering 
parts (0 = No, 1 = Yes) 

1 10000 sys\stb_parameter.dat 40 

Consider boltings for identical part 
search 

1 sys\stb_parameter.dat 55 

Handling of existing item numbers 
when inserting Steel Engineering 
parts 

1 sys\stb_parameter.dat 86 

Consider part attributes for identical 
part search (0 = No, 1 = Yes) 

1 sys\stb_parameter.dat 126 

Consider database part master for 
identical part search (0 = No, 1 = 
Yes) 

1 sys\stb_parameter.dat 128 

Set negative item number for 
modified Steel Engineering parts  

1 sys\stb_parameter.dat 143 

Increment for assembly item numbers 1 sys\stb_parameter.dat 151 

Increment for Steel Engineering part  
item numbers 

1 sys\stb_parameter.dat 153 

Increment for Standard Part item 
numbers 

1 sys\stb_parameter.dat 155 

Increment for non-Steel Engineering 
part item numbers 

1 sys\stb_parameter.dat 157 

Tolerance for identical part search 0.5 sys\stb_parameter.dat 184 

    

3-D  Dimensioning Settings    

Dimension line termination Slash sys\dimensioning_settings.x
ml 

 

Decimal places for linear dimensions 0 sys\dimensioning_settings.x
ml 

 

Decimal places for angular 
dimensions  

1 sys\dimensioning_settings.x
ml 
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Short description Default  HiCAD configuration file  Line 

Height of dimension figure 2.5 sys\dimensioning_settings.x
ml 

 

Height of dimension texts 2.5 sys\dimensioning_settings.x
ml 
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» Copy HELiOS standard masks 
This option should only be activated if you work exclusively on the basis of the ISD 
standard database. Please note that changes you applied to database masks will be 
overwritten. 

» Starter Configuration 
If you want HiCAD to be preset so that the automatic procedures of the novice 
configuration apply, activate this checkbox.  

» Use own templates  
Activate this option if you want to use your own configurations. Then select the 
relevant configuration file.  

 

2.7 Installing the HiCAD Viewer 
The HiCAD Viewer enables you to view drawings in HiCAD format (*.sza, *.szx) and 
output these drawings (in non-scale representation). This viewer is free of charge and 
may be provided free, without changing the scope of delivery.  
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3 Procedure for Silent Installations 
3.1 Installation Settings 
To configure the installation options, start the installation setup.exe as usual and make 
the required settings. 

In the last dialogue of the installation, click on Extended Settings. 

 

Here you can configure in particular the settings for the User Configuration and the 
Catalogs in such a way that user interactions will no longer be required. 

» Execute parameter configuration: Via CSV file,  

» Execute CatalogueMaker/CatalogueUpdate: Deactivate Interactive button. 
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Clicking Save creates a  

setup.ini  

file containing the desired settings. This file will be loaded automatically if it is located in 
the same directory as the Windows Installer package HiCAD.msi. Alternatively you can 
specify a file via the command line:  

setup.exe  SETTINGS=“<Ini-Datei>“ 
 
or 

 
msiexec  /i  HiCAD.msi SETTINGS=“<Ini-Datei>“ 
In this case the starting will not be “silent”, i.e. the installation dialogues wil appear, but 
with the default values of the .ini file. 

 

3.2 Redistributables 
Before distributing the installation you need to install the required redistributables on 
the target systems in order to circumvent the Microsoft-EULAs.  

Examples:  

vcredist.exe /passive 
 
dotNetFx40_Full_x86_x64.exe /passive 

The respective command line options of the individual Redistributable Installer can be 
called via the command line option /?.  

If required, the .msu files of the Windows Installer 4.5 can be installed with the 
Windows Package Manager pkgmgr.exe (http://support.microsoft.com/kb/934307/de). 

 

 You need to install the redistributables that are located on the DVD at Program32 or 
Program64 (except for the setup.exe and the language-specific folders such as de-de). 

 

http://support.microsoft.com/kb/934307/de


Procedure for Silent Installations 

   51 

3.3 Starting the Installation in the Silent Mode 
The installation can only be set to the silent mode via the command line: 

msiexec.exe  /i HiCAD.msi /passive 
 
or 
 
msiexec.exe  /i HiCAD.msi /qb!- 

Information on further command line options can be obtained via the command line, by 
means of the command msiexec /? , and via the Internet at 

http://technet.microsoft.com/de-
de/library/cc759262%28WS.10%29.aspx#BKMK_SetUI 
http://msdn.microsoft.com/en-
us/library/windows/desktop/aa372024%28v=vs.85%29.aspx 

 

3.4 Example of a Batch Installation incl. Redistributables and 
Log 

 
@set SOURCE=\\entw042\Setups\HiCAD 1700 
 
"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart 
@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error 
"%SOURCE%\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart 
@if errorlevel 1 echo Fehler bei .NET Installation && goto error 
 
msiexec.exe /qb!- /i "%SOURCE%\de-de\HiCAD.msi" /l*v 
"%SOURCE%\logs\%COMPUTERNAME%_HiCADInstallLog.txt" 
SETTINGS="%SOURCE%\Config\setup.ini" 
@if errorlevel 1 echo Fehler bei HiCAD Installation && goto error 
@exit 
 
:error 
@echo Installationsfehler %errorlevel% 
@net helpmsg %errorlevel% 
@pause 

http://technet.microsoft.com/de-de/library/cc759262%28WS.10%29.aspx#BKMK_SetUI
http://technet.microsoft.com/de-de/library/cc759262%28WS.10%29.aspx#BKMK_SetUI
http://msdn.microsoft.com/en-us/library/windows/desktop/aa372024%28v=vs.85%29.aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa372024%28v=vs.85%29.aspx
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4 Important Technical Information 
4.1 Data Compatibility HiCAD/HELiOS 2012 (Version 170X.x) 
Please note that no changes are made to the HiCAD data format and the HELiOS 
standard database within a major release. This means that all patches and service 
packs of a version (e.g. 1700.x, 170X.x) will use the same data format, and no HELiOS 
update will be required. 

  When updating from previous versions please note the following: 

 

Update from version HELiOS-Update (1) Changed HiCAD data format (2) 

1212.4 or older X (3) X 

15xx.(x) or older X X 

1601.(x) X X 

 

» Notes: 

 If a HELiOS update is necessary, older HiCAD, respectively HELiOS versions have 
no access to the database any more. All workplaces need to be converted at the 
same time. 

 If the HiCAD data format has been changed, drawings and parts cannot be loaded 
with the older version if they were saved with the new version. 

 After updating HELiOS, the database needs to be additionally converted from ANSI 
to UNICODE character set (for more information see the separate documentation). 
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4.2 Important Notes on Updates 
4.2.1 Carry Out Installation 
The installation of version 2012 can be carried out by a technician of the ISD or by the 
customer. In this context, please note the following recommendations by the ISD: 

» HiCAD without HELiOS 

 Update of version 2010 to version 2012: Can be carried out by experienced users 
with sufficient basics.  

 Update of version 2008 (or older) to version 2012: An installation by the ISD is 
recommended. 

» HiCAD with HELiOS 

 Update of version 2010 to version 2012: An installation by the ISD is 
recommended. 

 Update of version 2008 (or older) to version 2012: An installation by the ISD is 
recommended. The update installation includes a data conversion to UNICODE 
format. 

» 3rd party CAD with HELiOS 

 Update of version 2010 (or older) to version 2012: An installation by the ISD is 
recommended. 

 

4.2.2 Licensing 
Version 2012 can be obtained either on an installation medium (DVD), or via download 
from the ISD Homepage.  

As of HiCAD/HELiOS version 2010 the activation takes place via a software license. The 
activation is no longer linked to a dongle, but directly to the hardware of a server or an 
individual workstation. 

If you use a Server License, you need to update the License Server Software and the 
License Management Tools; if you use Local Licenses, you need to install the new 
version.  

Normally, licenses for older HiCAD/HELiOS versions must be revoked first.  
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After confirmation of the revocation you will receive one or several Entitlement IDs 
enabling you, in combination with your E-Mail address and your Password, to activate 
the new licenses. (see 5.3) 

Licenses can be deactivated at any time, without having to contact the ISD Group, via 
the License Activator in the ISD License Manager, i.e. they can be temporarily stored on 
the Server of the ISD. For this you require your Entitlement ID, your E-mail address and 
your Password. The activation can then be performed on any other computer, i.e. the 
licenses can be transferred to this computer. For Server Licenses this procedure can 
only be performed for the entire license License Pool.  

 After updating HiCAD and HELiOS (Version 2008 or older) to Version 2012, you 
must return your workstation dongle to the ISD. You can then no longer use any older 
HiCAD/HELiOS versions.  

 

4.2.3 CatalogueMaker 
The CatalogueMaker is called automatically by the installation program in case of a new 
installation.  

It specifies which standard series is to be shown in the standard part catalogues (at the 
moment standard series are available for DIN, ISO, EN, ANSI and JIS). The selection of 
the standards in the CatalogueMaker influences the display of the standard parts only, 
not their availability. This will still be controlled by the license selection in the 
configuration menu. 

The existing configuration will be taken over automatically in case of an update; the 
CatalogueMaker will not be started automatically. If you want to add standards to the 
catalogues, the program can be called in the ISD program group in the start menu via 
“Administration". 
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4.2.4 Computer / User Configuration 
A computer configuration for HiCAD settings can be activated in case of a new 
installation, respectively update. 

The “Workstation Parameter Configurator” can be started for a subsequent call by the 
Administrative Tools of the ISD program group. 

Depending on the selection in this window, the settings, saved in the corresponding 
CSV-file, will be configured. The default CSV-files can be found in the templates 
directory of the HiCAD installation. 

Important: 

» The settings files in the templates-directory will be overwritten without further queries 
in case of an update. 

» Company-specific CSV files can be filed in the sys-directory of the HiCAD installation; 
they can then be selected via the drop-down-list of the computer configuration. 

» Activate the HiCAD / HELiOS standard solution only when using the database 
supplied with HiCAD / HELiOS neXt 2007 or later. 

» When updating, the copying of standard masks must be activated only if no 
customized masks or BOMs are used. 

 

4.2.5 *.KRP to *.KRA Conversion 
(only relevant for updates from HiCAD neXt 2005 or older) 

As of HiCAD neXt 2006, the HiCAD 3-D parts (*.KRP and related files) are combined in 
one archive (*.KRA). 

Before making the necessary conversion, you should save the directories, where the 
HiCAD 3-D parts have been saved (these are usually the paths given for the file groups 
C:, L: and M: in the FILEGRUP.DAT file; please check further adaptations). 

You need the SZN-SZA-Konvertierung.exe program once for the conversion. The 
program can be found in the \isdtools directory on the HiCAD installation CD. 

Copy the UpdateTools directory (with all files and sub directories) to the computer you 
want to use for the conversion. 
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Start the SZN-SZA-Konvertierung.exe from this directory. The following window will be 
shown: 

 

» Enter the UpdateTools directory as the directory of the HiCAD neXt installation. 

» Select the directory of the KRP files and the destination directory for the KRA files 
(these directories may be identical). 

» Activate the Convert all KRP files in given directory option and decide if KRPs, 
which are no longer used, are to be deleted in one step and if subdirectories are to 
be included in the conversion. 

The conversion of the given directory will be started after selecting the Execute button. 

If you need to convert KRP files into different directories, the previous steps need to be 
repeated accordingly. 
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 We recommend the deletion of the KRP files, in particular when working without 
HELiOS, as they can still be loaded in HiCAD and can result in different states of KRP and 
KRA files. 

When using HELiOS functions, only KRA files are loaded, the change from KRP to KRA in the 
database is automatic during the database update with the help of the 
Helios2toHeliosNext.exe program. 

 

4.2.6 Important Notes on the Modules “Plant Engineering” and “Pipeline 
Isometry” 

HiCAD 2012 introduces a new file format for Plant Engineering parts. 

If you have used the modules “3-D Plant Engineering” and “Pipeline Isometry” in the 
previous HiCAD version, please note the following:  

It is assumed that the previous, old HiCAD version was installed at Y:\hicad , and the 
new version will also be located at Y:\hicad after the update (Y indicates the drive). 

11..  Before installing the Update, check in the old version the entry at position 6: in the 
FILEGRUP.DAT file that is located in the in the HiCAD EXE subdirectory. This entry 
determines the part directory for HiCAD Plant Engineering.  

Example 1: 

6:\\MyServer\hicad\PlantParts (or 6:\\MyServer\hicad\anlbautl) 

Here, a network path is specified for the Plant Engineering part directory, i.e. the 
part directory is located on a different computer. Create a backup copy of this 
directory.  

Example 2: 

6:X:\hicad\PlantParts  (oder 6:X:\hicad\anlbautl) 

X indicates the drive.   

Create a backup copy of this directory. 

Only if X is equal to Y, rename the part directory to Y:\hicad\MyPlantParts. 

If a directoryY:\hicad\PlantParts still exists in your old HiCAD version, rename it to 
Y:\hicad\PlantPartsOld. 
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22..  Now perform the HiCAD Update Installation. Please do not start HiCAD yet.  

 

33..  After the HiCAD Update Installation:  

After creating a directory Y:\hicad\MyPlantParts  as described in Example 2, now 
rename the directory Y:\hicad\PlantParts to Y:\hicad\PlantPartsOriginal , and then 
rename Y:\hicad\MyPlantParts to Y:\hicad\PlantParts (or Y:\hicad\anlbautl) 

In \hicad\exe\filegrup.dat at position 6: re-enter the directory path that was entered 
there in the old version. Check whether the following subdirectories exist in the part 
directory that has been entered there:  

CatSearch 

Symbols 

If one (or both) of these subdirectories is missing in the part directory (but only if this 
is actually the case!), copy it (them) from C:\hicad\PlantPartsOriginal to the part 
directory. 

If CatSearch already existed, copy the file CatDbAttMapping.txt from the directory 
C:\hicad\PlantPartsOriginal\CatSearch to the subdirectory CatSearch of the part 
directory and overwrite the already existing file. 

Copy the subdirectories 

PartInspect 

TemplateMacro 

VariantStruct 

from C:\hicad\PlantPartsOriginal to the part directory and overwrite the already 
existing files. 

 

44..  Start HiCAD and perform the update of the Plant Engineering part data as soon as 
you are prompted to do so by a corresponding dialogue.   
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4.2.6.1 Automatic update of part files (and database) 

If you have already created your own Plant Engineering parts with an older HiCAD 
version, you will, of course, want to re-use these parts in newer HiCAD versions. First 
make sure that you have entered the correct current directory path to your Plant 
Engineering part files at item 6: in \hicad\exe\FILEGRUP.DAT. 

Then start HiCAD. When you now try to load a drawing, or create a new drawing, the 
following window will be displayed:  

 

If you do not want to use the Plant Engineering modules right now, click Update later, 
and continue to work with HiCAD as usual. The window will not reappear until the next 
HiCAD start. 

If you want to use HiCAD Plant Engineering, click Update now. This will start the tool for 
the update of your part data. If you use the HELiOS database as part data source, the 
Login window appears (otherwise, you will be directly taken to the next window): 
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As you also want to update the database automatically, it is mandatory that you have 
the necessary write access (rights for the Administration function). 

When you click Login, the following window appears:  

 

 

Click Start. The update of the part data begins. Depending on the number of existing 
part files, this process will take 10 – 20 minutes; this time can be significantly longer if 
the data are transferred via a network. The updating was successful if an archive file 
could be generated for all parts with part master data (or catalogue entry, respectively, 
in case of the Catalogue as part data source). For all other parts, too, an archive file will 
be created if possible. If the updating was not successful, an error log will be displayed, 
indicating for each part whether or not an archive file could be successfully generated.  
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If the database is the part data source, the following changes will be made to the 
database, in addition to the update of the files: 

» In the document masters of the Plant Engineering parts, the file names will be 
modified, i.e. the extension .vad will be replaced with .vaa, and the extension .kra will 
be replaced with .paa. 

» The superordinate classes used for part classification obtain an ID, the so-called 
“industry ID”. (10001 for the class Plant Engineering, and 10002 for the class Air 
ducts). 

» The link definitions required for pipeline isometry will be entered (pipeline isometry 
and pipeline layout plan).  

» If a Vault Server exists and is activated, the archive files will be moved to the Vault 
Server. The files can then no longer be accessed via the Windows file system.  

After the update, click End and re-start HiCAD. Your parts are now available in HiCAD 
Plant Engineering. 

 

4.2.6.2 Auto-synchronisation of the database 

If you have not used an earlier HiCAD version and install HiCAD for the first time, the 
part files will directly be available in the new archive file format. It is however possible 
that the installed HELiOS database still needs to be adjusted accordingly. 

If this is the case, the following window will be displayed when you try to load a drawing, 
or create a new drawing:  
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If you are currently not working with the HiCAD Plant Engineering modules, click 
Update later, and continue to work with HiCAD as usual. This window will not reappear 
until the next start of HiCAD.  

If you want to use HiCAD Plant Engineering, click Update now. This will start the tool for 
the update of your database.  

First, the following Login window will appear: 

 

It is mandatory that you also obtain the necessary write access when you log in (rights 
for the Administration function). 

After you have logged in, the following window appears:  
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Click Start. The update of the database begins. Depending on the number of existing 
part files, this process will take 15 – 30 seconds; this time can be significantly longer if 
the data are transferred via a network.  

The following changes will be performed in the database:  

» In the document masters of the Plant Engineering parts, the file names will be 
modified, i.e. the extension .vad will be replaced with .vaa, and the extension .kra will 
be replaced with .paa. 

» The superordinate classes used for part classification obtain an ID, the so-called 
“industry ID”. (10001 for the class Plant Engineering, and 10002 for the class Air 
ducts). 

» The link definitions required for pipeline isometry will be entered (pipeline isometry 
and pipeline layout plan).  

» If a Vault Server exists and is activated, the archive files of the parts will be moved to 
the Vault Server. The files can then no longer be accessed via the Windows file 
system.  

After the update, click End and re-start HiCAD. Your parts are now available in HiCAD 
Plant Engineering. 
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4.2.7 Update Training 
ISD now offers a 2-day Update Training for new versions. Further information on 
training dates can be found on the attached form or our website: www.isdgroup.eu / 
News & Press Services / Training. 

http://www.isdgroup.eu/
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5 Licensing (Version 2012) 
HiCAD/HELiOS can be activated via three license types:  

» Network licenses 

» Standalone licenses (local licenses) 

» Commuter licenses 

 In the HiCAD directory DOCU you can find an Online Help for the Licence Manager. 
You start the Help by calling the LICENSEMANAGER.HTML file in the folder 
Docu\tools\Licensemanager.  

 

5.1 General Information about Licensing 
5.1.1 Local (Workstation-Specific) Licensing 
If you choose local licensing, the activation will be directly locked to the hardware of the 
workstation on which your HiCAD and HELiOS Desktop program is installed.  

The ISD will send you an E-mail containing the Entitlement ID for local licenses 
(standalone).  This ID will be required for the activation and deactivation of the licenses 
and software modules. Please keep the Entitlement ID! Without this ID you cannot 
activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will 
be possible without the Entitlement ID!  After installing HiCAD/HELiOS, you activate the 
licenses by means of the License Activator in the ISD License Manager. 

 



Licensing (Version 2012) 

 66 UNLIMITED PERFORMANCE 

5.1.2 Network (Server-Controlled) Licensing 
If you choose network (server-controlled) licensing, the license will be directly locked to 
the hardware of the server that centrally manages the HiCAD/HELiOS licenses. These 
licenses can be used on any workstation in your network that is connected to this 
server.  

The ISD will send you an E-mail containing the Entitlement ID. If you have several 
network servers, e.g. at several locations, you will receive one Entitlement ID for each 
network server. This ID will be required for the activation and deactivation of the 
licenses and software modules. Please keep the Entitlement ID! Without this ID you 
cannot activate or deactivate any licenses! In case of a defect, no reconstruction of 
licenses will be possible without the Entitlement ID!  You activate/deactivate the network 
licenses by means of the License Activator in the ISD License Manager.  

Individual licenses can be checked out from the server and locked to a workstation 
within or outside the network (so-called “commuter licenses”). This enables you to 
continue working at a different location, without being connected to the license server 
(unless your HiCAD/HELiOS installation requires a connection to a database server).  
For this purpose you define a specific period during which you want the license to be 
available on a selected workstation. For this period, this license will be blocked on the 
license server. After expiry of this period, the license will be made available on the 
license server again. It is also possible to manually return this license to the server 
before expiry of the defined period, if the workstation is connected to the server. 
Licenses for one workstation can be checked out for at least one day, with the counting 
beginning at 1:00 AM on the day following the checkout date.   

If you want to replace/exchange your license server, you need to deactivate all licenses 
first. 

 

 A static IP address is required for correct operation of the license server! 
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5.1.3 Practical Examples of Network Licensing 

» Let us assume that three licenses have been activated on your server. Monday 
morning (11.00 am) you suddenly need to see a customer for design tasks, and you 
know that you will still be on-site at the customer’s facility on Tuesday. You therefore 
check out a license for 24 hours on 11.00 am. This means that you can use this 
license until Tuesday night, 11.59 pm, from your mobile workplace. After expiration 
of this period, the license is automatically made available again on the server. If you 
manage to finish your work on Tuesday at midday, you can go back to your office 
and return the license to the server somewhat earlier. 

» Similar situation as the one described above, with the difference that you are not in 
your office on Monday, 11.00 am. In such cases you can generate a hardware ID, 
enabling your colleagues in the office to check out a license for you. This license is 
sent to you by E-mail and can then be activated. In contrast to the previous example, 
this license is exclusively available to you for a fixed period of time and cannot be 
returned to the server before expiration of this period.  

 

 For computers possessing a WLAN card: Please switch off the WLAN card before 
executing the Get Identification Code command!   

If you activate a license while the WLAN card is switched on, this license will only be 
valid and visible when the WLAN card is switched on. If, however, the license is 
activated while the WLAN card is switched off, the license will always be valid, no matter 
whether the WLAN card is switched on or off. 

As of Version 1701 the activation status of the WLAN card will no longer be relevant.  

 

5.2 Network Licenses 
To be able to use network licenses, a License Server needs to be installed on a 
computer without HiCAD/HELiOS.  

The license server enforces and manages licensing in multi-user environment. It keeps 
track of all the licenses and handles requests from network users who want to run a 
HiCAD/HELiOS application, granting authorization to the requesters, or denying 
requests if all licenses are in use.  
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The license server must not be installed on the same computer on which an ISD 
software product (HiCAD, HELiOS) is installed, as both product share system data 
concerning the licensing information. Formerly, such parallel installations of license 
servers and ISD products were performed in cases where a customer occasionally 
wanted to transfer the license to another computer (Remote Commuter License). As of 
Version 1700 such scenarios can be realised in a much more convenient manner with a 
new licensing procedure.  

 

 Please note:  

 As of Version 1700, parallel installations of license servers and ISD products (i.e. on 
the same computer) are no longer covered by the warranty. The ISD group advises 
you strongly not to perform such installations.   

 A static IP address is required for a correct operation of the License Server! 
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5.2.1 Server Installation 
The SafeNet License Server is installed from the HiCAD DVD. Start Windows. If 
Windows is already open, close all other applications. Insert the DVD in the DVD drive. 
The installation wizard will be started automatically. In the installation wizard, click the 
Standard Edition button, which opens a mask with various selection options for software 
components.   

 

Click the SafeNet License Server button to start the installation.  
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After successful installation you will find the Server (Sentinel RMS License Manager) 
under Services. From here you can also start and end the License Server.  

 

 

 

 

5.2.2 Client Configuration 
To ensure that the HiCAD/HELiOS Client finds the correct License Server, an 
environment variable LSFORCEHOST should be set on each Client using network 
licenses. The value HOSTNAME, respectively the IP address of the License Server is 
assigned to the variable. 
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5.3 Licensing via Entitlement ID (License Activator) 
Thanks to the enhanced ISD License Manager 2.0 the communication between the 
customer and the ISD could be facilitated significantly.  

 

5.3.1 AutoRequest Licenses  
When acquiring a HiCAD/HELiOS license, you will obtain one Entitlement ID for local 
licenses (Standalone) and another one for network licenses (Network). If you have 
several network servers, e.g. at different locations, you will obtain one Entitlement ID for 
each network server. These numbers will be required for the activation and deactivation 
of the licenses and the software modules.   

 

 

 Please keep the Entitlement ID! Without this number you cannot activate or 
deactivate licenses. In case of a system crash a reconstruction of the licenses cannot take 
place without the Entitlement ID! 
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After installing HiCAD/HELiOS you can find the program in the Windows Start menu at 
ISD Software und Systeme > Administration. Please note that for the execution of 
some functions, administrator rights are required.  

The range of functions of the ISD License Manager depends on the activation of the 
License Administration Tools option. The information about this setting is entered in the 
Registry and can also be changed there subsequently if desired (please contact the 
Hotline).   
 

 To activate/deactivate Network Licenses, always start the ISD License Manager (x32 
Server) via the Windows Start menu: Select Start > All programs > ISD Software und 
Systeme GmbH > Administration. 

 

Activate the License Activator tab and enter the Entitlement ID, your E-mail address 
and your Password. New customers obtain their password from the ISD Hotline. With 
this password you can also access the Download Area.  

 

After entering the data, click Login. The ISD License Manager 2.0 connects to the ISD 
License Server and the acquired licenses will be displayed.  

This process may take several minutes. You can then activate the licenses. 
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5.3.2 Activate Licenses 
After successful login, the number of available licenses and the number of acquired 
licenses are indicated next to each module. Select the modules to be activated and click 
Activate to start the activation.  

For Server Licenses the modules are already pre-selected! 

 

After successful activation a message showing you that all licenses have been 
successfully activated will be displayed:  

 

You can then log out and start working with the HiCAD/HELiOS modules. 

In addition, you will receive an E-mail informing you about the deactivated modules.  

For Network Licenses, all modules will always be activated or deactivated (for further 
information about the operation of the License Manager, please read the Online Help for 
the License Manager. 
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5.3.3 Deactivate Licenses  
A deactivation of licenses for modules will be required in the following situations:  

» Exchange of hardware or changing of hard disk partitioning 

» Update of the operating system (e.g. from Windows XP to Windows 7)  
For updates within one version no deactivation will be required. 

» Transfer of local modules from one workstation to another 

» Acquisition of further modules, or return of hired licenses 

» Switch from local licenses to network licenses 

Please note the following: All workstations with modules having the same Entitlement ID 
need to be deactivated completely before a redistribution of the module licenses can 
take place. 

After starting the ISD License Manager 2.0 the activated modules will be highlighted in a 
different colour. Click the Deactivate button to revoke the activation of the modules.  

 

A selection is not possible, as you need to deactivate all modules, no matter whether 
local licenses or network licenses.  
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 The deactivation must not be disrupted, e.g. by a logout or the closing of ISD License Manager 
2.0! 
 

After successful deactivation the following message will be displayed:  

 

 

 

5.3.4 Trial Licenses  
If you select Display trial licenses after logging in, you will be also shown, besides all 
trial licenses with a limited period of validity, all purchasable licenses which are not 
simultaneously available as trail licenses.  

 

5.3.5 Reconstruction of Licenses  
As all licenses are stored on the ISD Server, you can, in case of an interrupted 
connection or an accidental deletion of licenses, restore all licenses by logging in with 
your Entitlement ID. The restoring will only function if the hardware was not changed 
(see 4.2.3.3 Deactivate Licenses). 

 

5.3.6 Notes Regarding the Use of Mobile Computers (Laptops) 
If you use a computer with WLAN card, Please make sure that the WLAN card is either 
always switched on, or always switched off.  

As of Version 1701 the activation status of the WLAN card will no longer be relevant. 
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5.4 Commuter Licenses 
Commuter licenses enable you to use network licenses even if the workstation is not 
connected to the Server. There are two ways of receiving commuter licenses: 

» Via direct checkout from the License Server 

» Via checkout from License Server, without network connection 

 

 To activate/deactivate Network Licenses, Network Licenses always start the ISD 
License Manager (x32 Server) via the Windows Start menu: Select Start > All programs > 
ISD Software und Systeme GmbH > Administration.  

 

5.4.1 Direct Checkout from License Server 
Start the ISD License Manager (x32 Server) application (while a connection to the 
Server still exists). Switch to the Commuter License tab.  
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If you have set the system environment variable LSFORCEHOST, the entered License 
Server is displayed at start-up as pre-selection. Use the Search network button to 
automatically search for License Servers.  

Expand the tree structure of the found Server by a click on the “+”-sign. The result 
looks as follows:  

 

 

Select the required licenses by activating the corresponding checkboxes on the left 
hand side. On the right hand side, information on the selected license is displayed.  

In the Commuter license: Validity in days field, you enter the number of days that you 
want the commuter licenses to remain checked out from the Server. The maximum 
number of days is 60. By default (or if a “0” is entered), the value is set to 1.  

 

 For reasons of safety you should check out the licenses only for the required period! 
If a commuter license is lost, e.g. because of theft or a defect of the client computer, the 
license on the Server cannot be used any more before expiry of this date! 
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After entering the expiry date for the commuter licenses, activate the Update licenses 
button. 
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Commuter licenses are checked out from the Server. 

 

 

All selected licenses are now checked out from the Server and you possess all rights on 
your computer for the specified validity period for the commuter licenses. This means 
that you are enabled to work network-independent. The checked out licenses are no 
longer available to the other computers on the net.  

You can however also return the commuter licenses before their expiry date. To do this, 
you need to deactivate the checkboxes on the left hand side and click the Update 
licenses button. All licenses are now made available on the Server and locked on your 
computer, i.e. you can now only use HiCAD/HELiOS if there is a connection to the 
License Server. The licenses made available again can now also be used from other 
workstations. 
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5.4.2 Checkout from License Server, Without Network Connection 
Commuter licenses can also be drawn from the License Server without an existing 
network connection.  

 

 Please note that administrator rights are required.  
Commuter licenses checked out in this way cannot be returned to the License Server! This 
means that the commuter licenses that have been checked out from the Server are only 
(automatically) made available again after their expiry date. 

 

Several steps are required for this, by the administrator having a network connection to 
the License Server, as well as by the Client having no network connection to the License 
Server.  

The Client starts the ISD License Manager tool, switches to the Remote Locking Code 
tab and sends the generated character set to the administrator (via E-mail or over the 
phone). 
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The administrator starts the ISD License Manager (x32 Server) and switches to the 
Commuter License tab. The License Server is selected, and the required licenses 
(modules) are activated in the left window. To checkout a remote commuter license the 
administrator now needs to activate the Check out authorisation for remote computer 
checkbox. 

 

A click on the Update licenses button opens a new dialogue window, in which the 
administrator enters the character set received from the Client.  
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After selecting OK, another dialogue opens, in which you enter the target path and the 
file name for the licenses to be swapped out.  

 

Select OK to check out the commuter licenses from the License Server and swap them 
out to a file, e.g. RemoteLicCode.lic. 
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The successful checkout will be confirmed. The administrator then sends the file, 
RemoteLicCode.lic, to the Client.  

After receiving the file with the commuter licenses, the Client starts the ISD License 
Manager (x32 Server) again and activates the Install Remote Authorisation Code tab. 
Here the received commuter licenses can be installed directly via file selection or via 
copying of the file contents.  

 

Click the Install... button to install the commuter licenses on the Client.  
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After successful installation, switch to the License Info tab. Press the F5 (Update) key 
on your keyboard. You are now informed which licenses are installed locally on the 
computer.  

 

 

5.5 License Configuration 
Some cases may require the use of only certain specific licences on a computer. 
Example: On the License Server, HiCAD creator and HiCAD solution licences are 
available. On one Client, HiCAD is to be started with a HiCAD creator license, on 
another Client, HiCAD is to be started with a HiCAD solution licence. If the selected 
license is no longer available, an application start is no longer possible.  

 

 If there are several basic modules in a standalone (workstation) license (to which 
also the Commuter Licenses belong), it is mandatory to make a pre-configuration and save 
it as workstation configuration.  
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5.5.1 License Configuration HiCAD 
 

 

 

On the HiCAD Configuration tab of the ISD License Manager tool you have the option 
to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HiCAD is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HiCAD is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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5.5.2 Licence Configuration HELiOS 

 

On the HELiOS Configuration tab of the ISD License Manager (x32 Server) tool you 
have the option to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HELIOS is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HELiOS is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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5.6 Important Softlock/Hardlock Information 
When using the softlock/hardlocks as selector for the license file, please note that for 
system-inherent reasons the date must not be reset! Such resetting causes a blocking of 
the softlock/hardlock that can only be revoked by the ISD by means of a re-
programming. In such cases, we would have to charge you the costs of this 
unnecessary additional work. 

A change of the system time is possible, as long as it is not date-comprehensive. 

If you deem such date conversion absolutely necessary, please inform our staff on the 
hotline in good time. 

 

ISD Software und Systeme GmbH 

Phone: 0049 - 231 / 97 93 - 166 

Fax: 0049 - 231 / 97 93 - 101 

Mailto: hotline@isdgroup.de 

 

 IMPORTANT:  If you have a 64Bit version of HiCAD/HELiOS, the hardlock can no longer 
be used as license file selector due to missing driver support! 
 

5.7 Theft of a Workstation 
The user is responsible for appropriately insuring the HiCAD/HELiOS workstations 
against theft. If desired, we can tell you the reinstatement value of your software. If a 
workstation is stolen, you will need a new license. In such cases, please send us the 
police report of the theft first. We will then provide you with a license for a limited period 
of time, and submit an offer for a new license to you. The ISD will send you the new 
license after clarification of the case with your insurance and receipt of your payment for 
the license fee. 

mailto:hotline@isdgroup.de
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6 Licensing (Version 2011) 
As of HiCAD 2012, the licensing procedure should only be performed as described in 
Paragraph 4.  

For compatibility reasons, the following paragraph describes the procedure that is 
applied to Version 2011 and differs from the new procedure. 

 

6.1 Generate Identification Code and Send to ISD 
To generate the identification code, activate the Windows Start menu and select All 
Programs > ISD Software und Systeme > Administration > ISD License Manager (x32 
Server).  

 

 For computers possessing a WLAN card: Please switch off the WLAN card before 
executing the Get Identification Code command!   

 
If you activate a license while the WLAN card is switched on, this license will only be valid 
and visible when the WLAN card is switched on. If, however, the license is activated while 
the WLAN card is switched off, the license will always be valid, no matter whether the WLAN 
card is switched on or off. As of Version 1701 the activation status of the WLAN card will no 
longer be relevant. 
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On the first tab you will find all information required for the generation of a new license. 
Click the Send button to automatically generate an E-mail with all necessary 
information. The E-mail will be opened with your standard E-mail program, enabling you 
to add your own message if desired. Alternatively, you can save these data to a text file 
and e-mail them to ISD Software und Systeme GmbH.  

You can also send the Selector and Code keys back to ISD Software und Systeme 
GmbH by post. Please note however that this procedure will delay the licensing.  

Based on the keys, a license for your computer will be generated and e-mailed to you.  

You will receive from the ISD Software und Systeme GmbH a self-executing license file 
(when it is sent by E-mail, the name of the file is [filename].ex_ ; it needs to be renamed 
to [filename].exe before execution). Double-click to execute the license file. Please note 
that administrator rights are required for this.  
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After successful unpacking, the License Server is re-started automatically.  

Use the License Server Monitor tool to check the installed files.  

 

 

 

Expand the tree structure of the Subnet Servers entry to display all License Servers on 
your network.  
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Then expand the tree structure of the installed Server (test-server2003.int.isdcad.de). 
All licenses installed and managed on the License Server are displayed.  
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6.2 Local Licenses 
Local licenses are generated for a particular computer. To do this, activate the Windows 
Start menu and select All Programs > ISD Software und Systeme > Administration > 
ISD License Manager (x32 Server). 

 

 

 

Click the Send button to automatically generate an E-mail with all necessary 
information. The E-mail will be opened with your standard E-mail program, enabling you 
to add your own message if desired. Alternatively, you can save these data to a text file 
and e-mail them to ISD Software und Systeme GmbH.  

You can also send the Selector and Code keys back to ISD Software und Systeme 
GmbH by post. Please note however that the sending by E-mail is significantly faster.  

Based on the keys, a license for your computer will be generated and e-mailed to you.  

You will receive from the ISD Software und Systeme GmbH a self-executing license file 
(when it is sent by E-mail, the name of the file is [filename].ex_ ; it needs to be renamed 
to [filename].exe before execution). Double-click to execute the license file. Please note 
that administrator rights are required for this. 
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The licenses are now unpacked and activated. After successful installation, the local 
licenses can be viewed on the License Info tab of the ISD License Manager (x32 
Server).  

 

 Press the F5 key to update the list of licenses. 
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6.3  Revoke Network Licence for Hardware Component 
Exchange 

If you want to use a different computer as license server, or exchange hardware 
components (hard disk, graphic card, motherboard etc.) on the license server, the 
network licenses need to be revoked (i.e. locked) before the exchange. For this, the 
following requirements need to be fulfilled: 

» Administration tools need to be installed on the License Server. 

» All licenses on the network server need to be unlocked again. Please make sure that 
no application using these network licenses is running.  

» All commuter licenses need to be checked in again.  

» The License Server (service) must be running.  

 

 The revocation must take place before the exchange of hardware components. If the 
hardware is irreparably damaged, please contact the ISD Hotline (Email: 
hotline@isdgroup.de, Phone: 0049 - 231 9793 166). 

 

Now carry out the following steps: 

 

Step 1 – Generate Revocation Password File  

To prevent the revocation of network licenses by unauthorized persons, a corresponding 
password file is required, which is generated with the help of the License Monitor tool. 
Only persons knowing the password are granted the rights for the revocation of their 
network licenses.  

To generate the password file, proceed as follows:  

» Open the ISD License Manager (x32 Server). Select Tools > License Monitor 
(WlmAdmin.exe).  
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» Select Tools > Generate Revocation Password. 

 

 

The following dialogue is displayed:  

 

» Enter the desired password (at least 8, but not more than 32 characters). 
Please do not forget this password! Without the password you cannot revoke your 
network licenses!  

» Click Generate. The program prompts you to specify the storage location for the 
password file.  

» Select a location and click Save. The password file will be saved, with the file name 
sntlpassword.dat, to the selected folder. Please note that the file name must not be 
changed. Do not forget this storage location, as the file needs to be copied to another 
folder at a later time.   
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Step 2 – Copy Password File to Working Directory of License Server  

After generating the password file sntlpassword.dat, copy the file to the installation 
directory of the license server, if you have not already selected the directory when 
saving the file.  

Default paths are as follows:  

» Windows XP 32 Bit  
<OS Drive >:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS License 
Manager\WinNT 

» Windows 7 32 Bit  
<OS Drive >:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS License 
Manager\WinNT 

» Windows 7 64 Bit  
<OS Drive >:\Program Files(x86)\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT 

 

Step 3 – Revoke Network Licenses  

Please note that licenses can directly be revoked from a license server or from a client.  

» Start the ISD License Manager (x32 Server) tool. Open the Revoke Server License 
tab.  

» Enter the name of the server (LOCALHOST) on which you want to revoke the 
licenses. 

» Enter the port number of the license server (Default: 5093). You can use the Check 
Server button to check your entries.  

» Enter the number of the license version that you want to revoke. The version number 
can be checked in the License Monitor: Expand the Subnet Servers level containing 
the license server structure. The first number stands for the module number, the 
second number for the license version.   

» Now enter the password. If you forgot your password, please repeat steps 1 and 2.  

 



Licensing (Version 2011) 

   101 

 

» Click the Revoke network license button.  

» Select a storage location for the so-called "Revocation Ticket" file. The ISD requires 
this file for checking purposes and granting of new licenses.  

 

» An appropriate message will be issued, telling you whether the revocation was 
successful or not. 
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» Finally, send the revocation ticket to the E-mail address 
license_request@isdgroup.de. 

 
Step 4 – Send Revocation Ticket File to ISD Software und Systeme GmbH 

» Send the Revocation Ticket to license_request@isdgroup.de.    

 
Step 5 – Install License Server Software on New Server Computer  

The installation of the new License Server software and the detection of the new 
hardware ID on the new license server computer can take place before, at the same 
time of or after the revocation on the old computer.  

The sending of the license file for the new Server can, however, only take place after 
receipt and verification of the revocation file for the old computer. All Server Licenses 
created after 1 August 2010 will therefore remain valid and utilisable for 4 days after 
revocation.  

 

6.4 Revoke Local License for Hardware Component Exchange 
To revoke a local license for hardware component exchange, or for the transfer to 
another computer, the following preconditions must be fulfilled:    

» The revocation must take place before the hardware component exchange. If the 
hardware is irreparably damaged, please contact the ISD Hotline (Email: 
hotline@isdgroup.de, Phone: 0049 - 231 9793 166). 

» You must be logged with administrator rights on the computer on which the 
revocation is to be performed.  

» The HiCAD and HELiOS programs on the local computer must be closed.  

 

mailto:license_request@isdgroup.de
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Step 1 – Revoke Local License 

» To revoke a local license, activate the Windows Start menu and select All programs > 
ISD Software und Systeme > Administration > License Manager (x32 Server). 
Activate the Revoke Standalone License tab.   

For operation systems with user account control please execute the program by right-
clicking and selecting As Administrator; otherwise the functionality is greyed out.  

» In the LockLicense program, the HiCAD/HELiOS License option must be activated, 
then select the appropriate option for license revocation; in the License Manager no 
further selection will be required, you can immediately click the Revoke license 
button. 

» Click the Send revocation code button to create an E-mail containing all required 
information.  

If no mail client is installed, you can also make a screenshot and send it to the ISD 
(Email: license_request@isdgroup.de; Fax:0049 - 231 9793 288). In either case please 
also provide the name of the computer on which the revocation is to be performed, as 
this will facilitate the assigning of the revocation code. 

 
Step 2 – Request License for New Computer 

At the same time you can request a new local license. 

The sending of the new license file can only take place after the revocation code of the 
old hardware has been received and verified by the ISD; the revoked license will 
therefore remain valid and utilisable for 4 days after revocation.  

 

  

mailto:license_request@isdgroup.de
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7 HiCAD at a Glance 
HiCAD is a universal CAD system with true 2-D/3-D associativity, innovative functions, 
comprehensive industry solutions and an integrated PDM component. Up-to-date 
working techniques and numerous automatisms help you abridge routine tasks. 
Simulation and analysis tools enable you to detect and prevent possible collisions within 
your product models at early design stages.  

» Performance characteristics:  

 Microsoft Windows standard and GUI based on the Windows “Ribbons” 
technology 

 Combined working in 2-D and 3-D  

 Assembly-oriented design engineering providing top performance even for very 
large assemblies  

 Transparency and clearness thanks to convenient search functions, filters and 
multiple selection options  

 Extensive symbol and standard part catalogues 

 Simulation and analysis tools  

 Standardisation and automation 

 Direct modelling and parametric design 

 Integrated product data management with HELiOS  

 Data transfer from other systems (CATIA, ME10, STEP, DXF, DWG etc.)  

 BOM-creation, PPS interface, transfer to NC programs  

 Comprehensive industry solutions for Steel/Metal Engineering, Plant Engineering, 
Sheet Metal processing and Plant Engineering 

 Individually extendable due to a modular structure  
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8 First Steps in HiCAD 
8.1 Start HiCAD 
You start HiCAD by:  

» using the Windows task bar (Start) to choose the Programs folder and then clicking 

the HiCAD icon  in the ISD … menu, or   

» by clicking the HiCAD icon  on your desktop.  

Once you have started HiCAD, the input window for License Management is initially 
displayed, followed by the HiCAD Start Centre (provided that it has not been 
deactivated).  

 During start of HiCAD it is checked whether the required version of .NET 
Framework is actually installed. If this is not the case, an appropriate error message 
is issued and HiCAD is closed. 

 

8.2 DLL Check  
Due to entries in the Windows-Registry, more and more libraries from third parties (DLL 
file) are integrated when HiCAD is launched, e.g. in order to capture messages or 
outputs to the screen. Some examples are 

» Virus scanners, 

» PDF programs,  

» Programs for the recording of screen activities,  

etc. These files can sometimes cause problems.  
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When you start HiCAD, it will first be checked whether DLL files are assigned to the 
Registry value AppInit in the Registry key  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Windows (64Bit) 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows 
NT\CurrentVersion\Windows (32Bit) 

If this is the case, a message will be displayed, informing you that third party libraries 
integrated in your Registry may cause problems in HiCAD, and recommending to 
contact your administrator if you want to deactivate this mechanism.  

Activate the Suppress message checkbox if you do not want this message to be 
displayed upon future HiCAD starts. Also inform your administrator about the message. 
The message will not reappear until the Registry value changes again, i.e. not until other 
DLLs will be loaded!  

If you want to suppress the message completely, set the Registry value Check for 
AppInit_DLLs in the Registry key  

HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD2012\HiCAD 
2012 

to 0. 

 Be careful when editing the Registry! The entering of incorrect values or the 
deleting of values can destablilize the operating system! 

 

8.3 Close HiCAD 
To close HiCAD,  

» click the Close icon  or 

» click the ISD button and select End.  

If any HiCAD drawings are still open at this point, you can to save them.  

If you activate the Clear temporary directory? checkbox when closing HiCAD, all 
automatically created data backups will be deleted. 
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8.4 The Start Centre 
When you start HiCAD for the first time, the Start Centre is displayed, which has been 
designed to facilitate your first steps of drawing creation.  

 

Please note:  

» Click on the graphic to obtain information about the version number.  

» When you call the Start Centre again, the values that you set last will be displayed as 
default values.  

» The settings you have selected for the Create new drawing start action will even be 
used in HiCAD if you call the New drawing (without DB) function. 
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8.4.1 Create New Drawing 
If you want to create a new drawing, specify whether you want to create a part drawing 
or an assembly drawing by activating the appropriate checkbox.  

» Part drawing (detail drawing)   
In a part drawing (detail drawing) you divide your drawing into main parts and sub-
parts. To define the part structure you use so-called dummy parts which symbolise 
the assembly. You then assign assembly-relevant main parts and sub-parts to these 
dummy parts. Instead of dummy parts you may as well use the special component 
type Assembly.  

» Assembly drawing   
You can define 3-D drawings directly when creating the assembly drawing and - if 
you are working in parallel with HELiOS - enter them into the database. This provides 
significantly more efficiency, particularly for referencing, itemisation and BOM-
creation.  

 
 

8.4.2 Options 

» Enter drawing into database  
If you are working with HELiOS you can define here whether you want to the new 
drawing to be entered into the database. If you activate this checkbox, HiCAD will 
prompt you to specify the document master data once you exit the Start Centre. If 
not, you will be prompted to enter the name of the drawing file.  
Activate, if desired, the project to which you want to assign the drawing.  

» Scale  
Here you can preset the scale of the drawing.   

» Start mode  
Here, choose the start mode you want to be activated once you exit the Start Centre, 
e.g. 2-D, if you want to start the drawing in 2-D or 3-D Extruded solid, if you want to 
start your drawing by creating an extruded solid in 3-D.  

» Create processing planes (3-D only)  
Here you can specify which of the standard processing planes you want to create. 
Activate the appropriate checkbox.   
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» View projection and View representation (3-D only)  
If you want to work in 3-D, use these functions to pre-set the model view and the 
view representation.  

 

8.4.3 Load Existing Drawing 
If you have chosen Load existing drawing as start mode, you can specify whether you 
want to load the drawing via the database, the Explorer or via an interface. As with a 
new creation, you may also activate the project directly. 

 

8.4.4 Switch Start Centre Display Off 
If you activate the Switch Start Centre display off checkbox and click OK to exit the 
Start centre, the current settings will apply as the default settings for whenever you start 
HICAD again and create new drawings. The Start Centre is then no longer displayed. To 
re-activate the Start Centre display and to change the settings, choose the Activate Start 
Centre function. The changed settings will be applied when starting HiCAD again.  

If you click OK to exit the Start Centre, the current settings are used as the default 
setting if, on the other hand, you exit the Start Centre by pressing the ESC key or the  
icon, the settings are ignored.  
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9 HELiOS at a Glance 
On the way to the finished product, time expenditure, the cost situation and product 
quality can only be optimised if all departments of a company work together efficiently. 
This requires a well-structured and efficient exchange of information between the 
parties involved in the production process - from Manufacturing, Purchasing and 
Service to Marketing and Sales. 

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-
free gathering, distribution and management of the data that is required for the process 
chain. Once saved, these data can be re-used within the entire company and for the 
complete product life cycle. HELiOS manages and controls all process cycles by 
regulating and monitoring the processing and transfer of these data. 

Thus, the know-how of the company will be used optimally, redundant work can be 
avoided and error sources will be eliminated. 

HELiOS combines Product, Process and Peripherals Management to form a single 
system, thus making HELiOS the knowledge reservoir of your company. 

HELiOS can be integrated in your overall CAD system or used as a stand-alone system, 
the so-called HELiOS Desktop. 

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific 
requirements.  
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10 First Steps in HELiOS 
10.1 Program Call 
Start the HELiOS Desktop by double-clicking the HELiOS.EXE file in the \HiCAD\exe 

directory or via the program icon  on your Desktop. 

Default setting is the project-independent start. Please note that the list view in the 
right-hand window will not be shown when you start HELiOS Desktop for the first time. 
Select a project first and display the list view via View and then Lists. 

If you have not ended HELiOS correctly during your last session, you will receive an 
error message from the Vault Server.  

 

10.2 Registration 
The HELiOS User Management is based on the User Management of Windows. If 
several users are registered with the same Windows User Name in EDBSETUP, a login 
mask will appear when starting HELiOS Desktop.  

Name and active group enable the user to login with the rights guaranteed by the User 
Management.  

If you select a project from the Active Project drop-down list, this project will be opened 
after starting HELiOS Desktop. If you select the project-independent setting, all 
documents will be displayed. 

Start the HELiOS Desktop with Login (see below).  

To ensure that a specific project will be opened after starting HELiOS Desktop, you need 
to specify a Start Project. On the Ribbon, activate the Tools tab, then select Options, 
activate in the dialogue the General tab and choose a start project. 

 

mk:@MSITStore:D:\Dokumente%20und%20Einstellungen\sduempelmann.INT\Desktop\helios.chm::/AllgemeinesZuHeliosNext/Konfiguration_(EDBSETUP)/HELiOSKonfiguration.htm
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10.3 Login 
Use the Login  function for a new login while working with the HELiOS Desktop, e.g. 
to work with different rights without having to exit the program. 

» Activate the Login  function on the QuickAccess toolbar. 

» Select a different user.   

» If required, change the active project and confirm the new settings with Login.  
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11 How to Use the Help 
The Online Help provides you with information, descriptions and examples on all 
functions and techniques which are available in HiCAD – from 2-D and 3-D to the 
integrated PDM functionality, Sheet Metal Processing to Steel/Metal and Plant 
Engineering.  

 Please note that the scope of available functions may vary, depending on the 
configuration level of your HiCAD product. This means that some of the functions described 
in the Online Help may not be available. 
 
As of Version 2012, the Help will be available both locally (status of the installation DVD) 
and on the Internet (regularly updated) at help.isdgroup.com. Both versions of the Help 
can be called from HiCAD via the Help Topics and Information item (“?” icon on the 
top right of window). You can select your preferred Online Help type via ? > Help 
Settings.   
 

 
 

You call the HELiOS Help via Tools > Help Topics > General. Select your preferred 
Online Help type via Configuration > Options > Help. 
 

 
  
 
In order to use the Internet version of the Help, you need to register for the ISD’s new 
company Wiki once. This will not only give you access to the new Help, but also provide 
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you with many other information which will be made available shortly in the ISD Wiki 
(Forum, Download area etc.). 
 
Click Sign up in the login window of the Online Help to register. If you have already 
been registered, enter your access data and click Login to get directly to the start page 
of the Online Help.  
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Register for the ISD Wiki 
 
After clicking Sign up in the Login window of the Online Help, enter the data required 
for the ISD Wiki in the dialogue window. Confirm the security prompt and click the Sign 
up button. 
 

 
 
After the registration the dashboard of the ISD Wiki will be displayed. A message 
indicates whether you have been authenticated as an ISD customer.  
 
If you could be identified as an ISD customer, you can now directly launch the Online 
Help using your registration data.  
 
If you could not be identified as an ISD customer, please perform the steps described in 
the message.  
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12 What’s New in Version 2012? 
The following section provides you with an overview of changes, new features and 
enhancements in HiCAD 2012.  

12.1 Module-Comprehensive News 
» New Look & Feel 

 With optimised Ribbons and easily identifiable icons.  

 

 The Point options menu has been redesigned. It has new icons that can be 
hidden, shown, enlarged ad downsized (SP1). 

» Online Help 
A regularly updated version of the Online Help is now available on the Internet at 
help.isdgroup.com. You can preset which type of the Help you want to use. 

» Configure context menus 

Use the  icon on the bottom left of the menu to configure context menus 
according to your requirements.  

» Open drawings in read-only mode  
Drawings can now also be opened in read-only mode. 

» Keyboard commands 
You can now use the F12 key to repeat the last action.  

» Bills of Materials 

 A special BOM configuration, HICAD_Blech_01.RMS, is now available for sheet 
metal processing.  

 Steel Engineering BOMs can now also transfer avoirdupois weights to the Report 
Manager. 

http://www.help.isdgroup.com/
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» Configuration management 
HiCAD’s central configuration management (ISDConfigEditor.exe) allows the 
definition of customer-specific configurations for a wide variety of use cases, such as 
dimensioning, annotations, workshop drawing generation or fitting of vertical ladders. 
Once adjusted to company-specific requirements, these configurations can directly 
be used in the end user's HiCAD applications without having to define any further 
settings. 

» Workshop drawings / General drawing derivation 
The Steel Engineering workshop drawing functionality has been enhanced and can 
now also be used for general drawing derivation. The function can now also be 
applied to general parts. The function can now be found, as well as the functions for 
Itemisation and Detailing, on the Drawing tab. 

» Changed Default Settings in System Files  
The default settings have been changed in several system files: ABWPAR.DAT, 
ALG3DPAR.DAT und STB_PARAMETER.DAT. (SP1) 

» Thumbnails for KRA files  
KRA files (3-D part files) can now be displayed as thumbnails, i.e. as shaded preview 
images, in the Windows Explorer, in the HiCAD Viewer, when inserting parts via the 
Explorer as well as in the preview images in HELiOS (SP1). 

» Visualisation of User Interactions  
For various functions the visualisation of user interactions has been optimised. This 
applies, for instance, to the rotation of 3-D parts and sketches, or to the moving of 
objects: Rotation axes and displacement vectors/directions are now visualised very 
clearly. (SP1) 

» Unlocking of Locked HELiOS Documents / HiCAD Sessions 
Use the Start tool bottom in the HiCAD sessions dialogue to unlock HELiOS 
documents and HiCAD sessions that have previously been locked (SP1)  
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» Design Checker 
The Design Checker is a tool that enables you to increase the quality of your drawings 
and reduce costs and time through an early detection of errors in the design. You 
can auto-check your drawings for their compliance with specific construction 
guidelines. (SP1) 
New options of the Design Checker allow you to check sheet metal parts for 
segmented bend zones, and check the mountability of the boltings for parts in your 
drawings or assemblies. (SP2)  

» Cylindrical pin calculation  
You use this function to check whether a cylindrical pin that was inserted for the 
connection of two parts has the required stability to withstand a specific force. The 
function calculates the shear force in the shear joint, and the required minimum 
diameter of the pin. (SP1) 
You can now also select the material for cylindrical pin calculation. (SP2) 

» Print all view areas/Print all drawings 
Use this new function to print all or several model and sheet views of a drawing in 
one step. In addition, you can export the views as Postscript files and auto-convert 
them (with the help of an appropriate interpreter, e.g. Ghostscript) to PDF files or 
other formats, or combine them within one document. (SP1) 
Use the Print HiCAD drawing function to to print several drawings (even without 
HELiOS) in one step, without having to open them beforehand. (SP2)  

» AutoSave of data  
The dialogue for the AutoSave mechanism Shortly before carrying out the AutoSave, 
HiCAD will display the AutoSave window. (SP2)  

» HiCAD creator   
In the basic module HiCAD creator the maximum number of possible 2-D points has 
been increased from 2,000 to 10,000. (SP2)  

» Insert drawing frame  
When inserting drawing frames, the specification of the fitting point on the drawing 
frame is no longer required. The fitting point is now always the bottom left corner of 
the drawing frame. (SP2)  

» View scale in title block  
Besides the sheet number and the main scale of the drawing, you can use the 
$VIEWSCALE key to enter the view scale in the title block of the drawing frame. (SP2)  
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12.2 2-D 
» Revision clouds  

Revision clouds can now be inserted as main parts or sub-parts. (SP2) 

» Delete functions  
The new Delete list function enables you to create a list of graphical elements by 
identifying them with the cursor. Identified elements will be marked permanently. 
Right-click to end element identification. An OK, YES/NO query will be displayed. 
Select YES to delete all elements. In contrast to the Delete GE function, UNDO 
restores all deleted elements at once.  

» Part creation   
In the redesigned GUI, the 2-D -> 3-D Level -> Body function has been moved to 3-
D Standard > New > PullDown menu Extruded solid.  

» Scale text   
The new Scale functions enable you to scale texts through specification of a scaling 
factor. This can, for example, be useful when reading DWG files: If a DWG file with a 
1:1 scale is read in, and the scale is subsequently changed to 1:20, the texts will not 
be scaled together with the drawing. The new functions enable you to adjust the text 
height.  

» Text Editor and Annotation Editor  

 The Use attributes from the product structure can now be displayed in 
annotations. For this to happen you need to enter the text 
%DBVA(ATTRIBUTENAME). (SP2) 

 The HiCAD Drawing attributes, too, can now be used in annotation tags. For this 
to happen, enter the text %SA(ATTRIBUTENAME). (SP2) 

 When copying texts from RTF files or the clipboard to HiCAD, bullet lists, 
numbered lists and indents will be taken over as well. Before you insert the text, 
HiCAD asks you whether tab stops and indents are to be represented as blank 
spaces. In the Annotation Editor, texts that have been separated by tab stops will 
be arranged in columns when they are taken over. It can therefore make sense to 
replace the tab stops by blank spaces. (SP1) 

 CSV files can now be loaded into and saved in the Text Editor and the Annotation 
Editor. For RTF files (text and annotation), different formattings within one line are 
taken into account, except for superscripted and subscripted text. 
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 The column width for annotation tables can now be specified explicitly.  

 You can now freely select the size of leader line symbols, e.g. the arrow. The arrow 
size will be saved together with the drawing, thus retaining the symbol geometry, 
irrespective of the workstation. You can also preset in the file POS3DPARNEU.DAT 
the angle and width of symbols (in addition to their length) as defaults. 

 The key shortcut SHIFT+LMB now allows you to mark texts between the active 
field and the selected field in the Annotation Editor.  

» HiCAD creator  
The maximum number of possible 2-D elements has been increased from 2,000 to 
10,000. (SP2)  

 

12.3 3-D 
» Views and representation  

 The number of shortening directions for shortened views is now limited to three 
directions. 

 The new algorithm for sectional and detail views provides the user with a 
significant performance increase, especially for complex drawings. This is 
particularly useful in the field of metal and facade engineering.  

 Use the Lock projection function to fix views in such a way that they cannot be 
rotated out of the screen plane any more. You can find this function in the context 
menus for views. 

 Auxiliary geometries contained in the sketch will be considered for the generation 
of sectional and detail views. This means that edges marked as auxiliary 
geometries will have no influence on the geometric representation of the sketch. 
(SP1)  

 In central projection, curved geometries will now also be represented correctly in 
glass model views and Hidden Line views. (SP1) 

 The Shading mode function is no longer available. (SP1) 

 Centre lines, cross-hairs and Steel Engineering axes are always displayed as red 
dashed lines in Hidden Line Dashed representation. The overlap settings will be 
ignored, , as well as the corresponding pre-settings in the system file 
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ANSGEN.DAT. In contrast to this, the Hidden Line representation still respects the 
overlap settings for centre lines (SP2)  

 Use the new Copy 3-D view function to create a copy of the active 3-D view . 
(SP2)  

» Presentation of 3-D models  
3-D models can now be exported as 3D-PDF files. This interactive representation 
enables you to view and evaluate 3-D models from all sides and perspectives, even 
without HiCAD. The models can be moved, rotated, zoomed etc. In addition, the 
export formats U3D and JT are supported. 

» Sketches 

 The HCM functions for sketches and c-edges can now be found in the HCM 
function group of the Sketch tab.  

 When trimming lines to circles or arcs, the selected section of the line will be 
shortened or lengthened to the intersection point with the circle/arc that is nearest 
to the identification point (for the circle/arc).  

 In the Delete sketch menu you can find the Delete double lines function. This 
function enables you to delete lines or line segments that exactly coincide in a 
sketch. You can also use this function to delete overlaps (SP1). 

 3-D Sketches with HCM constraints are identified by the icon  in the ICN. (SP1) 

» Create parts 

 The functions 2-D->3-D Level -> Body and 2-D -> 3-D Conversion can now be 
found in the Extruded solids menu.  

 The functions Mould part and Fill part are no longer available.  

 The Copy part is no longer available. Use the functions in the Clone function group 
instead.  

 New parts can now already be identified as BOM-relevant parts during their 
insertion. In the corresponding dialogue windows, activate the BOM-relevant 
checkbox. 

 There are various scaling options for the placing of c-edge sweeps: Evenly, Retain 
height and Retain cross-section.  
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» Process and model parts 

 New copying functions are available in the Move and Rotate menus of the Clone 
function group. These enable the creation of multi-body structures by means of 
pattern clonings:  

• Clone part, rotatory pattern  
Clones the active part or part list in a rotatory pattern, i.e. by placing the 
clones about a rotation axis.  

• Clone part, along c-edge  
Places clones of the active part or part list along a c-edge. 

The transformation of the original along the c-edge can also be performed with 
direction specification. (SP1)  

• Clone part, on grid  
Clones parts or part lists on a grid, via linear displacement, rotation or along a 
c-edge, if desired also with vertical displacement.  

 Use the Deform function to deform parts by bending them along a defined sketch. 
The sketch plane determines the neutral axis for the bending process. Possible 
are the following types of deformation: bending, twisting, tapering and stretching. 
Twisting, tapering and stretching are possible as of SP1. 

 Use the Wrap function to create raisings, indentations and imprints on parts by 
wrapping of sketches onto part surfaces. 

 The dialogue window of the Part properties in sectional views and cut-outs 
function has been redesigned.  

 The Model set function is no longer available. Use the targeted showing and 
hiding of parts and part lists to process parts from large assembly drawings 
separately.  

 The Tapered polyhedral fillet option is no longer available. Use the Polyhedral 
fillet, variable function instead. 

 The separate functions for Hyperedges are no longer available. Functions 
involving the using of hyperedges, e.g. the sketch processing, c-edge sweep and 
polyhedral fillet functions, now have the hyperedge specification option in their 
dialogue windows.  

 When you are using HELiOS, you can now also exchange parts via the document 
and part master.  
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 The default setting for automatic weight and surface area recalculation Update 
weight of parts (0:never; 1:when itemizing; 2:always) in the ALG3DPAR.DAT file 
has now be set to 1 (when itemizing). (SP1) 

 The Hide part list in active view function is now also available in the context menu 
for 3-D parts when selecting parts /part lists in the drawing. (SP1) 

 The Trim to surface  and Draught  function can now be found in the Trim  pull-
down menu of the Process function group on the 3-D Standard tab. (SP1) 

 If you select 3-D Standard > Tools > Surface > Surfaces, Further > Change 
colour, Individual, a corresponding feature log entry, Appearance, will be created. 
For each surface of a part to which a particular colour has been assigned, a Facet 
with parameter sub-entry indicating the assigned colour will be created in the 
feature log. (SP1) 

 The Scale function can now be found in the Process function group of the 3-D 
Standard tab. This function now automatically creates a Feature log. The functions 
Scale Volume, Surface area and Weight are no longer available. (SP2) 

 Weight 
If you use the Part Attributes function to assign a weight to a 3-D part by entering 
a particular value, you can activate the Fixed checkbox to lock this field and 
prevent an overwriting of the entered value by HiCAD. (SP2)  

» Standard Parts and Standard Processings  

 The context menu of weld seams now contains the new Change font that enables 
you to change the text parameters of a weld seam tag (font, colour, text height 
etc.) subsequently. 

 For various thread runouts, e.g. according to DIN 76, the Thread runout dialogue 
window will be displayed after exiting the catalogue system.  

It contains the new checkboxes Free point angle and Bore depth = Drill bit. If the 
Free bore depth checkbox is activated, the additional checkbox Bore depth = Drill 
bit will be made available. If you activate this checkbox, the drill bit will be the end 
point of the thread runout. The drill bit value, too, can be entered explicitly if 
desired.  

The Bore depth=Drill bit checkbox option is also available for blind holes.  

 Weld seams can be displayed in standard representation (mechanical 
engineering) or special, simplified representation (steel engineering).  
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 If you select a sheet main part to be welded on, the weld seams will be determined 
for all sub-parts, and superfluous (double) powder marking lines will be removed. 
If a sub-part is selected for a welding, only the sub-part will be welded on.  

 When inserting threads (e.g. DIN 13) you can select between left hand and right 
hand threads.  

 In the system file NORM.DAT you can now use the item Prüfung der Sacklochtiefe 
( > 0 -> erforderliche Mindestmaterialdicke, <= 0 keine Prüfung ) [Check blind 
hole depth (> 0 -> required minimum material thickness, <= 0 no check)]  to 
enter a parameter for the checking of blind hole depths, i.e. you can preset the 
required minimum material thickness.  

 Standard processings now also include bores and subtractions in the shape of 
filleted rectangles.  

 You can now also add fasteners from the Factory standards > User-defined 
fasteners catalogue, such as anchor screws or dowels, which enables you to use 
customized fastening elements for boltings. 

 You can now invert the direction of a bolting subsequently. 

 In the selection dialogues for Standard Parts and Materials you can now restrict 
the number of parts/materials offered for selection by setting appropriate filters. 
(SP2)  

 When inserting Standard Parts, Standard Processings etc. via the Catalogue 
system, you can now use an extended search function. (SP2)  

 The tables for the bolts according to DIN EN 14399 contain a column called SET 
for the bolting set ID. This column determines the BOM-relevance of nuts when 
bolting sets are inserted. (SP2)  

 For this purpose, the dialogue for the insertion of boltings has been extended. 
(SP2) 

 When inserting weld seams and weld seam symbols you can now also choose an 
empty entry from the listbox instead of a selection from dimension a to dimension 
z. (SP2) 

 Powder marking lines can now also be created for other 3-D parts, and not just 
for Sheet Metal parts.(SP2) 

 The catalogues for Fasteneres have been expanded, e.g. by nuts according to 
DIN6923, Cylindrical pins according to DIN EN ISO 2338, Screws and Bolts with 
coating, Oval head screws with TORX, ISO7045-X30 etc. (SP2)  
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» Texts and Annotations 

 Load text from file  
Comma-separated CSV files can now be loaded with the Text Editor and the 
Annotation Editor, formattings will however not be taken over. In contrast, fonts 
can be taken over from formatted RTF files. Here, even various formattings within 
a line will be considered, except for subscripted and superscripted text.  

When loading formatted RTF files, indents, tab stops, bullet lists and numbered 
lists of the original text can be taken over for annotations. (SP1) 

 Paste text from clipboard  
Indents, tab stops, bullet lists and numbered lists of original texts can also be 
copied and pasted from other Windows applications for annotations. (SP1) 

 Save text   
Texts can be saved with the Text Editor and the Annotation Editor as comma-
separated CSV files for a later re-use. 

 You can now explicitly specify the column widths for annotation tables.  

 You can now freely select the symbol sizes of leader lines, e.g. the size of the 
arrows. The arrow size will be saved with the drawing, thus retaining the symbol 
geometry independent of the workstation. In the file POS3DPARNEU.DAT you can 
now preset, besides the symbol length, the angle and width of symbols as default 
values.  

 In the Annotation Editor you can now use the  icon to mark all texts of an 
annotation. Use the SHIFT + LMB to mark the texts between the active field and 
the selected field. 

 The Use attributes from the product structure as well as the HiCAD drawing 
attributes can now be used in 3-D annotation tags. (SP2)  
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» Dimensioning 

 Arc dimensions can now also be created as chain, parallel and running 
dimensions.  

 If a dimension tolerance is added, changed or deleted in a drawing containing a 
fits table, HiCAD will ask you immediately after the modification whether you want 
to update the table. When you subsequently save the drawing, the query will no 
longer appear.  

 You can now separately specify the colours for texts, symbols and leader lines of 
surface symbols.  

 Dimension line projections can now be separately switched on and off in the 
dimension parameters for linear, running, angular, arc and radius dimensions and 
for heights above datum.  

 Dimension figures can now also be displayed with a white rectangular background 
on printouts of shaded views.  

 New options for units of measurement are in (inch, am.) and " (inch, brit.). 
Selections made in in  or " are always converted to ft and inches, and the 
dimension figure will be output in mixed format, e.g. 11' 3 1/4", or 11 ft 3 1/4 in. 

 Decimal places of values in in (am) and " (brit.) can also be represented in the 
form of fractions. For this purpose, the changing options for parameters also 
include the new options Round value, Fixed denominator and Reduce fraction. 

Examples: 

• Original value 10,12, Highest denominator 8 -> 10 1/8  

• Original value 10,24, Highest denominator 8 -> 10 1/4  

 The handling of dimension base points for non-updateable dimensions can be 
preset with the HiCAD configuration management (ISDConfigEditor.exe) namely 
via COMMON > DRAWINGS > ANNOTATION > DIMENSIONING.  

 You can now define the desired behaviour of the dimension figure size and the 
dimension line position during zooming, by defining the parameters for parametric 
dimensions and HCM dimensions accordingly.  

 The context menu for tabular annotations now contains the new Move annotation 
function. Annotations that have been moved with this function will be restored to 
their position relative to their fixed point when they are updated. (SP1)  



What’s New in Version 2012? 

   127 

 Dimension tolerances will now be sorted automatically in such a way that the 
greatest value will always be placed at the top (or at the front, respectively). This 
concerns the Dimension Figure Editor and the functions of the Dimensional 
tolerances menu. Dimensions in existing (old) drawing files remain unchanged. 
(SP1) 

 If desired, parametric dimensions can also show the variables/formulas contained 
in the feature items. This is possible for parametric dimensions of solid primitives, 
extruded solids, revolved solids, standard bores, fillets and chamfers. Default 
setting is Dimension figure+variable/formula. (SP1) 

 Use the Dimension figure, Apply text function to copy auxiliary dimension 
annotations to other dimensions - including all parameters (font, size, position 
etc.). (SP2) 

» Performance 

 Faster loading of large drawings thanks to various internal enhancements.  

 The updating of referenced parts now takes place much faster. 

 HiCAD offers the option of data reduction for a faster assembly creation.For the 
representation of referenced 3-D parts/assemblies, HiCAD will basically load and 
display a polygon model, thus reducing the memory consumption for large models 
and increasing the performance. (SP2)  

» Referencing 

 If you are using HELiOS you can specify in the DB configuration (Configuration > 
Install > Database > HiCAD) when the exchange of parts in drawings will be 
permitted. 

 Referenced parts of the active drawing can be protected against accidental 
modifications with the Lock against processing function (right-click referenced 
part > Referencing functions > Lock against processing). (SP1) 

» 3-D Grid 
The edge parameters (Colour, Line type, Layer) of 3-D grid lines can now be selected 
freely. (SP2)  
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12.4 Steel Engineering 
» Fit and process beams and profiles 

 Multi-part beams and profiles can now also be derived from sketches.  

 When placing beams and profiles along c-edges, the selected c-edge may only 
consist of straight lines and circular arcs.  

 In contrast to other steel engineering beams, beams derived from sketches also 
allow point displacements (in a rectangle) crosswise to the beam axis.  

 Grid steps can be exchanged against other steps in the HiCAD catalogues. To do 
this, select Further functions > Exchange > Grating step. (SP1) 

» Connections and variants 

 The former functions Column connections acc. to DAST IS, one-sided and 
double-sided have been replaced with the design variants 1302 and 1303. These 
also allow a direct fitting of welded seams.  

 The flexible front plate connection (1320) has been enhanced.  

 A new design variant is available for double-sided front plate connections (1322). 

 The former design variant for purlin joints with 2 plates and mitre cut acc. to DAST 
IH has been replaced with the design variant 1201, which also allow a direct fitting 
of weld seams. 

 The strap connection (1310) has been enhanced, now also enabling a direct 
fitting of weld seams. The connection can also be used for double T- and double 
U-beams.  

Depending on the fitting situation, the beam to be connected will be notched 
automatically. The corresponding settings can be specified in the Notch tab. (SP1) 

 New design variants for the fitting of pipes are now available. Weld seams for 
stiffeners (SP1) and connecting plates on the beam can also be fitted.  
If desired, weld seams can be generated on the pipes. (SP2) 

 Connections can now directly be deleted via the Delete connection function on the 
Ribbon.  

 The Copy connection function enables a multiple copying of a selected connection 
or design variant without having to identify the original variant several times.  
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 The variant 1 plate with mitre cut (201) has been replaced with the variant Purlin 
joint with mitre cut (1202). This variant also uses the new dialogue. (SP1) 
If desired, weld seams can be generated on the flange or the web. (SP2)  

 The design variant Base plate + Anchor plate (1101) has been enhanced 
significantly. For example, it is now possible to define additional stiffeners in web 
and flange direction. The dialogue for this variant has been redesigned. (SP1)  

 Also new is the design variant Cross-bracing with turnbuckle/tensioning element 
(1602). The design variant for the Cross-bracing (9501) has been renamed to 
Cross-bracing (1501). (SP1) 

  Connections can now be directly deleted via the Delete connection function on 
the Ribbon. 

  The Connect pipes function is now available as a design variant in the Civil 
Engineering functions docking window. (SP2) 

» Stairs and railings 

 Stairs and railings are now called via the Civil Engineering functions docking 
window. A new stair type, Concrete stairs is now available. 

 The boltings that are available for straight stairs are defined in the configuration file 
STAIRS SCREW JOINT.INI. In this file, configurations for bolts of the type 
DIN 7990 and a strength of 5.6 ,as well as bolts of the type DIN EN 14399-4 and 
a strength of 10.9 are pre-defined. (SP2)  

 The boltings that are available for railings are defined in the file RAILING SCREW 
JOINT.INI. In this file, configurations for bolts of the type DIN 7990 and a strength 
of 5.6, with a flat washer, a wedge disc 5%, a wedge disc 8%, and a wedge disc 
14%, as well as bolts of the type DIN EN 14399-4 and a strength of 10.9, with a 
flat washer, a wedge disc 5% and a wedge disc 8% are pre-defined. (SP2)  

» Workshop drawing 

 The functions for workshop drawings can now be found in the 
Itemisation/Detailing function group of the Drawing tab. 

 For sheet metal parts, you can choose in the workshop drawing between a 
representation with and without hidden edges. Default setting is without hidden 
edges.  

 In the settings for view groups, you can define the visualisation separately for 
standard views, sectional views and axonometric views.  



What’s New in Version 2012? 

 130 UNLIMITED PERFORMANCE 

 In the settings for view groups, you can determine that beams will be displayed in 
shortened representation in axonometric views. 

 The loading of view groups created for workshop drawings has been speeded up.  

 During view group creation for parts and assemblies, the respective type of use will 
be evaluated. 

 If you use an external drawing as target, and load the drawing parameters from a 
predefined configuration, parts appearing exclusively as attached parts in the 
workshop drawing will not be included in the drawing BOM either. This means that 
the BOM-relevance for these parts has been deactivated in the workshop drawing. 
This behaviour can be changed via the configuration management.  

 The function Workshop drawing – Change settings, active view group enables a 
subsequent definition of the views to be generated.  

 When updating derived drawings you can deactivate the rearranging of views. This 
can be useful, for instance, if you want to retain your own view arrangement 
during updating.  

 When adding view groups to sheets that already contain views from derived 
drawings, it is now possible to switch off the automatic rearranging of views. You 
specify this setting via the Configuration Editor. The default setting is 2, i.e. you will 
be asked whether you want the views to be rearranged. (SP1) 

 In the configuration management (ISDconfigeditor.exe), the dimensioning rules 
(available via Common > Drawings > Generation > Usage_Dependent > COLUMN 
> WSD_DiMRULESET) have been changed as follows:  

• STWDIMRULE_7: Position 2 (previously 1)  

• STWDIMRULE_9: Position 2 (previously 1)  

• STWDIMRULE_45: Value for all views = 0  

• STWDIMRULE_46: Value for view 1 = 1, Value for view 2 = 2  

• STWDIMRULE_47: Value for all views = 0  

• STWDIMRULE_50: Value for view 1 = 2, Value for view 2 = 1  

• STWDIMRULE_61: Value for view 1 =2  

 Dimensioning rule 10, direction "Perpendicular to beam axis" has been changed. 
When dimensioning attached parts, HiCAD now creates one individual dimension 
in the vicinity of the part.  
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 The dimensioning rules 8 and 10 apply dimensioning to plate sub-parts even if the 
plate surface runs parallel to the view and the part contains bores.  

 The new weld seam annotations (as of HiCAD 2011) are now also used in 
workshop drawings.  

 Lengths of mitre cuts are no longer dimensioned via the rules 21 or 23. If desired, 
you can now dimension mitre cuts with the rules 64 or 65.  

 If you use the drawing parameters of a configuration, the part environment will not 
be displayed by default. To change this, use the Configuration Editor 
(ISDConfigEditor.exe) (SP1)  

 You can specify either HiCAD or Windows paths for drawing frames via the 
Configuration Management. (SP1) 

 You can now enter the value 6 for the Position parameter of the dimensioning 
rules for columns (vertical beams). For chain dimensions, the position of the 
drawing will then be selected in such a way that the chain dimension is located as 
closely as possible to the 2nd base point. This possibility exists for all chain 
dimensions, but not for individual dimensions such as length, height, width, 
diameter or angle. (SP1). 

 For external PDM-managed drawings you can now specify in the configuration 
management whether missing sectional views are to be created in case of an 
updating of derived drawings. Default setting is 0 (do not rearrange). Furthermore, 
it is now possible to switch off the automatic rearranging of views in PDM-
managed drawings. The default setting is 1 (rearrange). (SP1) 

 When adding view groups to sheets that already contain views from derived 
drawings, it is now possible to switch off the automatic rearranging of views. You 
specify this setting via the Configuration Editor. The default setting is 2, i.e. you will 
be asked whether you want the views to be rearranged. (SP1) 

 As for beams and profiles, the configuration management now also provides 
dimensioning rules for attached sheets and plates per side. One distinguishes 
between "Web, front" (BEFORE_WEB) and "Web, back" (BEHIND_WEB) as the 
side for the attachment. (SP2)  

 You can now use the AutoSync sectional views option to specify how to proceed 
with sectional views that are still missing or have become superfluous. (SP2) 

 The dialogue of the Glass from sketch function has changed. The dialogue 
enables you to load and save configurations for glass panes, taking also the type of 
coating into account. (SP2)  
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» Itemisation/Identical parts 

 The type of bores (workshop, construction site etc.) can now also be considered 
for identical part search. In the parameter settings for itemisation, activate the 
Production type for bores (workshop, site, ...). Checkbox. In this way you can, for 
example, specifically deactivate bores intended for installation for NC output. 

 In the file STB_PARAMETER.DAT in the HiCAD SYS directory, the default setting 
for geometrically identical part search has been changed. The default setting for 
the entry Bei der geometrischen Gleichteilerkennung alle Teile berücksichtigen 
[Consider all parts for geometrical identical part search] (0=no; 1=yes) is now 1, 
i.e. all parts will be considered.(SP1) 

» Other new features 

 Steel Engineering BOMs can now also transfer avoirdupois weights to the Report 
Manager.  

 Axis annotations are assigned to the grid main part 3-D GRID. This allows you to 
hide the grid part while retaining the grid annotations. 

 During dimensioning of parts, the annotations will be placed in such a way that 
they do not overlap the processings. (SP2)  
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12.5 Metal Engineering 
» Grid plugin  

To provide a maximum of user-friendliness in the field of metal engineering and 
glazing construction the Metal Engineering planning grid plugin functionality has 
been further. Basic forms of complete facades containing beams, profiles and 
connections can now be created with only a few mouse clicks.  

» Foils and insulations in 3-D 
To enable a 3-D processing of foils, sealings and material insulations, the working 
technique for sectional views has been applied to these elements. 

» Alucobond-Profile series 
The Alucobond profile series has been included in the Factory standards > Factory 
beams catalogue. (SP1) 

» Cross-Section Properties  
Use the new Attr. (Define cross-section properties) function in the Metal 
Engineering, 2-D function group to assign part attributes to a cross-section. (SP1) 

» “Fixing bracket” design variant 
The Civil Engineering functions docking window now contains the new Fixing bracket 
Metal Engineering design variant. It is available in three different versions. These 
fixing brackets can be mounted onto intermediate ceilings, thus allowing a fastening 
of facade mullions to solid bodies. (SP2)  

» The dialogue of the Glass from sketch function has changed. The dialogue enables 
you to load and save configurations for glass panes, taking also the type of coating 
into account (SP2)  
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12.6 Sheet Metal 
» Base sheet 

 New sheet from surface  
Use the New sheet from surface function to construct, via specification of a sheet 
thickness, new sheet metal parts from the surfaces of a 3-D body. (SP1) 

 New sheet from solid  

• When converting an itemised solid to a base sheet, the item number and the 
BOM-relevance will be transferred. (SP2) 

• When creating a base sheet from a 3-D solid, you can now choose whether 
the sheet is to be generated with or without a bend zone. (SP1) 

 Semi-finished products  
When creating base sheets you can now load semi-finished materials data from 
the CatEditor, i.e. the sheet thickness, bend radius, allowance method will be 
taken from the CATEditor.  

» Attach flanges  

 Attach flange entry in Feature log  
You can now change the fitting mode via the Attach flange Feature log entry. You 
can choose between the options Attach, without shortening, With reference sheet 
shortening and With offset to reference sheet. (SP1) 

 Z-fold between 2 points   
The new function Attach Z-fold between 2 points function enables you to attach 
two contiguous sheets with relief groove creation. 

 Attach sketch   
The Attach sketch function now also allows a mirroring of the sketch. The flange 
will be fitted in negative X-direction according to the sketch. Right-click to switch 
the sketch to positive X-direction before identifying the connecting edge.  

» Design variant “Sheet corner”  
The insertion of the Design Variant “Sheet corner” takes place via the “Civil 
Engineering functions” docking window. Double-click either the name or the preview 
image of the Design Variant. Then, identify the insertion edges. In the dialogue 
window you can then adjust the parameters of the sheet corner variant to the sheet 
metal part.  
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» Close Corner, Outer Edge Flush  
Use the new Close corner, Outer edge, flush function to lengthen each sheet to the 
outer edge of the other sheet. This also applies to the bend zone. (SP1) 

» Solid from sheet  
When converting an itemised sheet to a solid, the item number and the BOM-
relevance will be transferred. (SP2) 

» Sheet Development  

 To ensure an error-free processing, e.g. during laser cutting, the line elements 
must not be smaller than the laser beam. Before creating the development you 
can set a minimum line length. In this way it is ensured that, for example, the 
length of circular arcs will not fall below this minimum length during development. 
You specify the minimum value in the CAM-relevant minimum length of 
development entry in the ABWPAR.DAT file in the HiCAD sub-directoy SYS. (SP2) 

 In sheet developments, threads are now created as sub-parts, as in 2-D. This 
representation consists of a three-quarter circle. This applies to the new 
development and updated old developments. The modified structure will be taken 
into account for DXF export. (SP1) 

» Bend zone representation 
 In HICAD, bend zones can be displayed with or without segmentation. To display the 
segmentation, change the following entry in the SYS/ABWPAR.DAT file as shown 
below:Cylindric representation of bend zones (yes/no=1/0)(without segmentation = 
2) 1. Restart HiCAD for the changes to take effect. New bend zones will then be 
displayed with segmentation. 

» Mitre  
If the angle on a flange becomes too sharp, a neat closing of the corner is no longer 
possible. In such cases you can use the new Mitre, narrow side function that creates 
a stepped 45 ° mitre.  

» Processing direction  
You can now identify the Processing direction and processing side by means of a 
direction arrow. This enables you to perform the development from the side that has 
been identified by the arrow, and automatically align it horizontally to the direction 
symbol. This is also an advantage in case of DXF exports.  
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» Powder marking lines 

 In the Powder marking lines menu, the selection options for sheets to be 
projected have been extended, e.g. by the With selection of attached parts option. 

 The Powder marking lines function can now also be applied generally, and not just 
to Sheet Metal parts. the function can be accessed via 3-D Standard > Standard 
processings > Bore > Powder marking lines. (SP2)  

» Lettering 
The Lettering function can not only be applied to sheet metal parts, but to all 3-D 
parts. It has therefore been moved to the 3-D Standard tab. To access the function, 
select 3-D Standard > Standard Processings > PullDown menu Bore > Lettering.  

» Weld seams  
If you use the 3-D function Weld seam (3-D Standard > Standard Parts) for a 
welding on of a sheet main part, the weld seams will be determined for all sub-parts, 
and superfluous (double) powder marking lines will be removed. If a sub-part is 
selected for a welding, only the sub-part will be welded on.  

» Bills of Materials   
For sheet metal processing the special BOM configuration HICAD_Blech_01.RMS is 
now available.  
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12.7 Interfaces  
» General  

 The performance for the loading and saving of drawings has been generally 
enhanced in HiCAD 2012.  

 The functionality and the dialogues for import and export processes have been 
revised and optimised.  

 The compatibility with new versions of foreign formats has been enhanced further. 
These include Catia (V4 and V5/R21), Inventor (2012), SolidWorks (2011), IGES, 
ACIS, DXF/DWG (14/ 2010), JTOpen, Parasolid (V22), Pro/E, Unigraphics and 
VDAFS. (SP1) 

» New 3-D Export formats  

 HiCAD 2012 supports the export formats 3D-PDF, JT and Universal. 

» Autocad (DXF/ DWG) 

 The saving of DXF and DWG files has been enhanced further:  

• The dialogue has been redesigned. 

• The performance has been increased, enabling a continued working in HiCAD 
during the saving process  

• You can now create individual DWG files without DXF format being required.  

 Free edges and isolated points can be transferred, as well as continuous line 
hatchings (also cross-hatchings), whose transfer can also be suppressed if 
desired.  

 Enhancements and optimisations have also been made to the sheet metal-relevant 
functional area the DXF interface.  

» Step 

 A new dialogue is available for the import and export of .stp files.  

 The STEP data exchange has been technically revised. It is now also possible to 
process free c-edges (wireframes), and the reading of error-prone STEP files has 
been improved.  
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 The transfer STEP file layers to HiCAD has been optimised. Thanks to these 
improvements the intermediate step of an MTA export will no longer be required.  

 During the export of Step files, the progress of the export is shown by a progress 
bar. (SP1) 

 It is now also possible to read referenced STEP files, enabling a selection of 
individual STEP parts of a structure tree. (SP2)  

 HiCAD Sheet Metal parts can be united during STEP export, which allows a more 
efficient processing in other systems. (SP2)  

» DSTV  

 The DTSV-NC interface now also allows the exclusion of bores from the export. 

 Punch marks will now no longer be created on the outer edges of beams/profiles, 
but can be moved by a value. (SP2)  

 The file name can be automatically generated from the document or part number 
of the HELiOS Database. (SP2)  

» FEM  

 The FEM interface is no longer available.  

» CADENAS PartSolutions  

 When transferring parts from Cadenas PartSolutions to HiCAD, the Cadenas 
attributes "Part No". and the designation will now be transferred to the HiCAD part 
structure by default. (SP1) 

 Furthermore, PartSolution parts can now also be inserted as sub-parts. (SP2) 

 In the new HiCAD PARTcommunity download portal by CADENAS, 3D-
CAD models in all common formats (including the HiCAD format) and from all 
fields of industry are now available. You can also directly access the portal via the 
import dialogue, if the file type is set correspondingly. (SP2)  
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12.8 HCM 
» Redesigned GUI and functionality  

 The HCM functions have been restructured. You can now find the 

• 3-D C-edge HCM on the Sketch tab, 

• 3-D Part HCM on the 3-D Standard tab, and  

• 2-D Part HCM on the 2-D Part tab. 

 The functionality has been generally enhanced, e.g. concerning the display and 
identification of HCM constraints.  

 HiCAD provides a further performance increase for several HCM-relevant 
functions. (SP1) 

» Additional point options  

 The point options M (mid point), S2 (intersection point) and QP (quad point) can 
now be snapped during definition of HCM constraints. 

» Improved references to projections of external geometries 

 Older versions provided rather limited possibilities for the placing of HCM 
constraints onto edges (via projection of the edge onto the sketch plane) outside 
the active sketch. This shortcoming has been resolved in the new version that 
interprets projected geometries as fully-fledged elements having the same 
properties as the sketch geometry. Thanks to this enhancement, it is now also 
possible to define coincidences with ellipses of external drawings, or coincidences 
and tangential constraints with circles of external drawings. 

» References to intersecting geometries  

 When setting constraints, you can now also refer to the intersection of the sketch 
plane with a facet or an edge. This opens up completely new possibilities for 
parameterisation. If, for instance, you select a facet, you will refer to its intersection 
with the sketch plane. If you select an edge, you refer to its projection onto the 
sketch plane. This enables you, for example, to place a sketch edge vertically on a 
surface.  
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» Direct dragging  

 It is now possible to drag a sketch by dragging one of its edges (in the element 
selection mode).  

» Zoom-independent HCM dimensions and parametric dimensions 

 You can use the parameters for HCM dimensions and parametric dimensions to 
determine whether dimension figure sizes and dimension line positions should be 
zoom-independent.  

» HCM-identification of sketches in the ICN   

 3-D Sketches with HCM constraints are identified by the icon  in the ICN. (SP1) 

 

12.9 Catalogue Editor 
» For customer-specific attributes, the columns CUSTOM1 - CUSTOM5 are now 

available.  

» The Settings function has been removed from the HELiOS menu. To access this 
function, select Settings > HELiOS Settings. 

» The menu bar of the Catalogue Editor now features the new Settings menu 
containing the functions HELiOS Settings and Track changes in HiCAD - ON/OFF. 

» Normally HiCAD regularly checks whether the catalogues are available in their most 
current version. This check can be activated by selecting Settings > Track changes 
in HiCAD – ON. If this checking option has been deactivated, the catalogue data will 
be loaded into HiCAD only once, and it will no longer be checked whether more 
current data are available. The current status (ON/OFF) will be entered into the 
Windows Registry. 

» As a simultaneous updating of the catalogue from different clients can destroy the 
catalogue, only one update can be made at a time. If the user starts another update 
during the process, a corresponding message will be issued and the catalogue will 
remain unchanged. 
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» HiCAD now offers the new beam and profile series VHP by Voestalpine. These are 
available in the FACTORY STANDARDS catalogue. 

» Use the new Assign to system colours option to transfer standard parts to the 
Colours system table and assign to particular colour to them.  

» The new Duromere catalogue is now available under Materials > Plastics. Also new 
is the Elastomere catalogue. (SP1)  

» The new profile series Alucobond profile series has been added to the Factory 
standards > Factory beams catalogue. (SP1)  

» The Material Manager (materialmanager.exe) that enables you to transfer the 
materials in the Catalogue Editor to HELiOS, now also allows a transfer of user-
defined materials in the Factory standards catalogue. (SP1) 

» You can now set filters to refine your searches. (SP2)  

» Use the AutoCopy data records function to copy complete blocks of data records 
from one or several catalogue tables in one step, and assign particular (new) 
expressions to these records. (SP2)  

» Use the Remove table from catalogue function to delete tables from catalogues. The 
corresponding .IPT files will be retained. (SP2)  

» In the GLASS TYPES table of the catalogue MATERIALS > GLASS. Here you can 
assign a coating type to a glass type. (SP2)  
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12.10 Feature Technology  
» The redesign of HiCAD’s GUI also includes enhancements and new functions in the 

field of Feature Technology. For instance, simplified parts are now appropriately 
marked in the feature log.  

» The performance for feature recalculation has been increased by up to 30 %, even 
for very complex parts.  

» Display of formulas and variables for parametric dimensions  
You can now also display variables and formulas stored in the feature logs in 
parametric dimensions. This is possible for parametric dimensions of solid primitives, 
extruded parts, revolved parts, standard bores, fillets and chamfers. Default setting is 
Dimension figure + Variable/Formula (SP1) 

» The Scale function can now be found in the Process function group of the 3-D 
Standard tab. This function now automatically creates a Feature log. If you do not 
want this, use the functions of the Scale menu. (SP2)  

 

12.11 Freeform Surfaces 
» The Remodel option for transition pieces is no longer available. 

 

12.12 Viewer 
» Use the Print detail function to exclusively print selected details of a model.  

» RPA files (P+ID projects) can now also be opened with the HiCAD Viewer. All 
relevant sheets will be displayed, and you can switch between the sheets. (SP1) 
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12.13 Report Manager 
» For Report Manager outputs from HELiOS, line breaks with carriage return (CR) and 

line feeds (LF) in the data  (multiline text attributes) will be replaced with spaces 
U+0020 (Unicode Character SPACE). (SP2)  

» When generating Bills of Materials via the configuration files (*.RMS) supplied with 
HiCAD, a column with the name MODULE will be created. For this column a filter 
criterion depending on the template used is defined, ensuring that Assemblies 
(dummy parts with the ID 27) Welded assemblies (dummy parts with the ID 32) will 
not appear in the BOM. (SP2) 

»  For Plant Engineering and P+ID BOMs, new templates (VBS scripts) for the export to 
Excel are available: (SP2)  

 P+ID BOM with symbol information 

 P+ID BOM with HELiOS information  

 Plant Engineering BOM for the entire drawing 

 

12.14 Plant Engineering / Variant Editor 
» New file format 

HiCAD 2012 introduces a new file format for part variants as well as for Plant 
Engineering parts. For parts and variants, respectively, there is now only one file, 
namely an archive file comprising the files of all representation types in compressed 
form (.VAA for Variants, .PAA for Parts).  

» Creating your own parts and variants 

 Because of the new data format, the procedure for the creation of new parts and 
variants has changed.  

 The specification of the COMPONENT_TYPE attribute is no longer required when 
creating user-defined parts. (SP1) 

» Pipeline configuration 
The dialogue for pipeline creation now offers the option to load and save pipeline 
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configurations. A pipeline configuration comprises the settings for the pipeline shown 
in the dialogue, i.e. colour, layer, pipe class and nominal width. 

» Part data synchronisation 
The new part data synchronisation function replaces the Variant AutoSync function 
that was available in previous versions. The new tool enables the transfer of the part 
data required for Plant Engineering to the HiCAD Catalogue.  

» Settings 

 Part selection 
If the option Database has been selected as part data source in the Parts from 
field of the Plant Engineering Settings dialogue, the industry key that is to be used 
for part searches in the database is displayed.  

The options for the specification of minimum and maximum pipe lengths for the 
automatic insertion of straight pipes can be found on the new Straight pipe 
tab.(SP1) 

 Part insertion 
Switching of representation types do no longer require a switching of the part 
directory, as all representation types are now contained in one archive file. 

 Straight pipe  
On this tab you can specify the minimum and maximum length for the insertion of 
straight pipes. (SP1). 
Parts of the type Straight pipe to which the connection type 10000 (welded) has 
been assigned, can optionally supply loose flanges when they are inserted. (SP2)  

 Link to P+I  
Use the List button to determine which part types are to be considered for the 
checking of symbol links. (SP1) 

» PAA Editor 
This new tool enables you to create a PAA archive from the files for the various 
representations of a Plant Engineering part (non-parameterised, i.e. no variant), or to 
change the contents of a PAA archive.  

» Pipeline isometry 
Isometric drawings now use their own, isometry-specific links, by default and without 
release-relevance. These links are always created directly with the part master. The 
special link types are Pipeline-Isometry and Pipeline-Layoutplan. They are normally 
automatically entered into your database via an update tool.   
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» Symbol Editor 
The Symbol Editor has been adjusted to the new part file formats (.VAA, .PAA). In 
HiCAD 2012 the Symbol Editor can only be operated after a conversion of the old 
data to the new formats. Due to these changes, the support of a Vault Server is now 
also possible.  

» Check symbol link 
Use the Check symbol link function to check which parts of the layout plan have 
been linked to a symbol in the P+ID. This function can be found in the Load pull-
down menu in the Link to P+ID function group of the Plant Engineering tab. (SP1) 

» New Plant Engineering parts 
Various new PVC-U plastic parts of the company Georg Fischer, Pipe branches and 
Loose flanges. (SP2) 

» Bent pipe 
The special functions for the placing of bent pipes on guidelines are no longer 
available. Instead, a bent “straight” pipe is now placed onto a composite edge in the 
same way as a non-bent pipe. Furthermore, the condition that a bent pipe must 
always occupy its own composite edge does no longer exist. (SP2) 

» Variant Editor 
The Variant Editor (ANVAREDIT.EXE) has been enhanced and adjusted to the VAA 
file format. For VAD variants, a separate tool (VAD-Editor.EXE) is available that still 
offers the old functionality (before Version 1700). 
You can now assign preview images to simple variants and structured variants 
subsequently. (SP2) 
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12.15 P+ID 
» Work directory: Number of drawing thumbnail (SP2) 

Formerly the P+ID always occupied the HiCAD thumbnail with the highest number 
(i.e. number 18). Now, the P+ID can be processed in any thumbnail. 
As a result, the directory structure of the processed file changes as follows: 
..\PID\WORK\Number of drawing thumbnail\Name 

» Dialogue texts  

 Redirect dialogue texts in comment dialogues (SP2) 
You can also use several placeholders in the form of ^Tn (n = Row number in 
database mask) in the Comment dialogue of a symbol data mask. You can place 
arbitrary texts before, between and after the placeholders. The text contained in 
the Comment dialogue can consist of a maximum of 255 characters after 
automatic replacement of the placeholder. The text replaced via a placeholder 
may also consist of a string for database attributes access. 

 Take over database attribute as dialogue text (SP2)  
The taking over of a database attribute value as dialogue text is also possible for 
pipeline symbols. 

• If you have assigned a pipe class to a pipeline symbol, you can use 
%DBPCLAT(name1) to access the value of a pipe class attribute. name1 
stands for the name of a pipe class attribute , e.g. PRESSURE. 

• If you have also assigned a "Straight pipe" part to the pipeline symbol, you can 
use %DBAT(name2) to access the value of a part attribute of the straight 
pipe. name2 stands for the name of a part attribute, e.g. D_AUSSEN 
(D_OUTER for "Outer diameter"). 

» Edit several symbols (SP2) 
Use the new Edit several symbols function to change data mask contents for several 
symbols of a P+ID project at once. The data of the symbols will be collected in the 
Edit symbol dialogue window. The <different> entries in the Dialogue text window 
indicates that the values for this dialogue type are different for the selected symbols.  
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» Connection, (poly)line and Connection, diagonal  
For both functions, a list of defined connection types will be displayed. Select the 
desired connection type with a double-click. Use the cross-hairs to specify the points. 
After creating a connection line, you can directly create another one with the same 
connection type without having to open the selection list once again. (SP1) 

» Update representation of connections  
Owing to the new possibility to define an arbitrary number of connection types, the 
functions for the updating of connections have been adjusted accordingly. (SP1) 

» Measuring point with circle and Measuring point without circle  
If you select the functions Measuring point with circle and Measuring point without 
circle, the list of defined connection types will be displayed as well, but only 
containing the signal connections. (SP1) 

» Settings 

 Switch off tag for KKS pipeline symbol (SP2)  
The pipeline tag which is normally used for pipeline symbols according to KKS can 
be switched off if desired. To do this, deactivate the Pipeline tag checkbox on the 
Symbol tab. If this option is deactivated, pipeline symbols and pipeline information 
will be graphically represented in the same way as with the identification according 
to DIN.To retain the desired pipeline annotation, you need to adjust the symbols 
_PIPE0 and _PIPE2 (in the symbol library ISDDINSYM1_...) beforehand. 

 Pre-define an arbitrary number of connection types (SP1)  
Via the P+ID Settings on the Connections tab you can define an arbitrary number 
of connection types. Each connection will obtain a name. The name need however 
be unambiguous within the connection types (Pipe connection, Signal connection, 
Drive connection).  

» Connections between different pipelines  
In older versions, connections between different pipelines could only be created via a 
separation symbol. This restriction can now be eliminated if desired.  

» Check part insertion  
Use the new Check part insertion to check whether a corresponding part in the 3-D 
layout plan has been assigned to a P+ID symbol. (SP1) 
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» Check symbol identification for uniqueness  
The symbol identification can automatically be checked immediately after entry or 
modification within the loaded P+ID project. This setting can be selected on the 
Symbol tab in the P+ID Settings dialogue.  

» Ignore industry presetting during part search 
This new option (on the Symbol tab in the P+ID Settings dialogue) affects the part 
search when assigning parts to symbols with the Edit symbol  function.  

» Edit pipeline 
If the HELiOS Database is used for the management of the part data, an extended 
dialogue is now available for the editing of pipeline symbols. 

» Part master attributes in the title block 
As of HiCAD 2012, attribute contents of part masters linked to document masters of 
the P+ID can be displayed in the drawing frame. 

 

12.16 HELiOS-HiCAD BIM-PLM Suite 
» As of Version 2012, HiCAD’s BIM-PLM functionality will be controlled via a separate 

license.  

» The performance for part and document master data transfer has been increased 
significantly.  

» The functions for workshop drawings and detail drawings have been replaced with 
the Drawing derivation function.  

» For external PDM-managed drawings you can now specify whether missing sectional 
views are to be created in case of an updating of derived drawings. Default setting is 
0 (do not rearrange). Furthermore, it is now possible to switch off the automatic 
rearranging of views. You specify this setting via the Configuration Editor. The default 
setting is 1 (rearrange). (SP1)  

» The BIM Status of the current drawing is indicated in the ICN by appropriate icons 
(SP2)  
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» Via Configuration Management (ISDConfigEditor.exe in the HiCAD sub-directory EXE) 
you can determine under which circumstances the “Drawing is up to date” link 
should be set. This is done via the parameter CONDITION ‘DRAWING IS UP-TO-
DATE’. (SP2)  

» When saving drawings, itemisation is no longer performed automatically. (SP2)  

 

12.17 HELiOS PDM in HiCAD 
» Redesigned GUI and functionality  

 The redesign of HiCAD’s GUI also includes smaller changes concerning display 
and menu structure of the PDM tab. 

 The general performance of a number of PDM-relevant functions has been 
increased.  

» Exchange 3-D part, via database 
The function Exchange 3-D part , which was previously only available via the 
Explorer, now also enables an exchanging of parts via the database (i.e. via 
document master or part master).  

» Unlocking of Locked HELiOS Documents / HiCAD Sessions 
Use the Start tool bottom in the HiCAD sessions dialogue to unlock HELiOS 
documents and HiCAD sessions that have previously been locked (SP1) 

 

12.18 HELiOS Desktop  
» Redesigned GUI and enhanced functionality 

Enhanced functionality for Drag &amp; Drop behaviour (also for Folder and Project 
structures).  

 The dragging of a document from the Windows Desktop into the HELiOS Desktop 
results in an import to the HELiOS Desktop, while the source file will be retained. 
(SP2) 

 Optimised search functions and result lists. 
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 Optimised display and behaviour of list views and tree structures, also for project 
structures. (SP2)  

 Documents can be loaded as read-only files (via context menu 

 When re-importing files, you can now also check in files with changed extensions 
(e.g. files changed from .doc to .docx) (SP2) 

 New Mark-Up /Redlining options (SP2) 

• It is generally possible to indicate in result lists whether a redlining document 
exists for a file. 

• If a mark-up document exists for a .SZA file that has been opened in the 
HELiOS Desktop, you will be asked if this document should be opened.  

» Multiple classification 
It is now possible to assign objects to several classes and Lists of Characteristics, 
which do not need to be in a hierarchical relation to each other. 

» Text fields with line break  
Text attributes can now contain more than 255 characters and consist of several 
lines. To be able to use this new feature, use the Mask Editor to assign the 
corresponding attributes (New: Unlimited text length, Line break possible) to the text 
fields.  

» MS Office and CAD Interfaces 
Helios 2012 offers plugins for the following versions of external CAD systems:  

• Autocad 2011,  

• Inventor 2011, und  

• Solid Works 2011  

(32 and 64Bit); 

as well as a permanent interface to MS Office (including Outlook). 

» The Plug-in for SolidWorks has been enhanced. Besides, it is now possible to insert 
Standard Parts in HiCAD via the part master of the HELiOS database. (SP2) 

» Material Manager: Transfer of user-defined materials  
The Material Manager (materialmanager.exe) that enables a taking over of materials 



What’s New in Version 2012? 

   151 

from the Catalogue Editor to HELiOS, now also allows a transfer of user-defined 
materials in the Factory standards catalogue to HELiOS. (SP1) 

» Support of further formats in the Plot Manager  
In the HELiOS Desktop, documents can be converted to other formats via output to 
the Plot Manager. Besides the DXF and DWG formats, an output as Iges, Step or 3D-
PDF file is now also possible. (SP1)  

» Terminal Server adjustment  
To ensure a smooth operation of HELiOS in a Terminal Server environment, several 
adjustments and optimisations of the system have been carried out. (SP1)  

» Internet Server  
The HELiOS Internet Server provides the option to access, with the help of a web 
interface, an active HELiOS database, where you can then search for and call detail 
masks for documents, parts, folders and projects as a client. (SP1) 

» Vault-Server for several suppliers  
Thanks to an enhancement of the Vault Server architecture it is now possible to 
provide specific Vault Servers with particular contents via a central Vault Server. For 
more detailed information, please contact our Consulting staff. (SP2)  
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